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Introduction

Essential safety precautions and an overview of the printer's main features, components, software options and
printing possibilities.

Safety precautions

Ensure proper use of the printer to prevent the printer from being damaged.

ENWW

Follow these precautions at all times:

Use the power supply voltage specified on the label. Avoid overloading the printer's electrical outlet with
multiple devices.

Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service,
see HP Support Center on page 97.

Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power cord. A
damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-approved
power cord.

Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the
printer. Doing so may cause fire, electric shock, or other serious hazards.

For printers without a stand:

e  Useasupport strong enough to hold at least twice the total combined weight of the printer, supplies,
and accessories.

e  Ensure the printer fits fully within the support's surface.
e  Ensure that the support is used exclusively for the printer.
e  Ensure that all the printer rubber bearings are located fully within the support's surface.

e  Follow the assembly instructions that came with the printer, and keep them available to ensure safe
usage.

Power off the printer and unplug the power cord from the power outlet in any of the following cases:
e  When placing your hands inside the printer

e [fthereis smoke or an unusual smell coming from the printer

Safety precautions
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e If the printer is making an unusual noise not heard during normal operation

e  Apiece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of

the printer
e During an electrical storm (thunder and lightning)

e  During a power failure

e  To avoid being pinched, keep your fingers away from the gap between the bottom of the printer and

the stand while you're moving the printer with stand.

Using this guide

This guide can be downloaded from the HP Support Center.

Seeh

ttp://www.hp.com/go/DesignJetStudio/manuals.

Introduction

This is a brief introduction to the printer and its documentation for new users.

Use and maintenance

To he

|p you carry out normal printer procedures.

Topics include the following:

Connecting the printer on page 11

Setting up the printer on page 14

Personalizing the printer on page 17

Paper handling on page 23

Printing on page 30

Mobile Printing on page 30

Practical printing examples on page 40

Handling ink cartridges and printhead on page 51

Maintaining the printer on page 55

Troubleshooting

To he

Ip you solve problems that may occur while printing.

Included are the following topics:

Troubleshooting paper issues on page 66

Troubleshooting print-quality issues on page 76

Troubleshooting ink cartridge and printhead issues on page 85

Troubleshooting data communication issues on page 86

Troubleshooting general printer issues on page 92

Text messages and numerical error codes on page 95

Chapter 1 Introduction
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Accessories, support and specifications

Reference information, including customer care, the printer specifications, and part numbers for paper types, ink
supplies, and accessories.

Accessories on page 64, HP Customer Care on page 97, and Printer specifications on page 100.

Glossary

The glossary contains definitions of printing and HP terms used in this documentation.

Glossary on page 104.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and cautions

Symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from being
damaged.

Follow the instructions marked with these symbols:

AWARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or
death.

A CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

Printer models

The user guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name
HP DesignJet Studio 24- in Printer DJ Studio - 24
HP DesignJet Studio 36-in Printer DJ Studio - 36

[% NOTE: Theimages appearing in this User Guide may not look the same as the printer you have.

Main features

HP DesignJet Studio Printer series are four color inkjet printers, designed to deliver CAD / Construction drawings
as well as high quality graphics.

Paper up to 610 mm (24 in) or 914 mm (36) wide can be used to print on. Some major features of the printer are
shown below:

e  Print resolution of up to 2400 = 1200 dpi using the Best print-quality option, the Maximum Detail option
and photo paper

e  The printer can be controlled fromits front panel or from a remote computer using the Embedded Web
Server, HP DesignJet Utility*. It can also be controlled from your tablet, or from your mobile device with the
HP Smart App.

ENWW Printer models 3



e  Handles roll and cut-sheet paper, with @ multi-sheet tray which automaticaly switches between both
e  Touch-sensitive front panel in color, with an intuitive graphical user interface

e  Supports USB, Ethernet, or Wi-Fi connection

e Includes Web-connected features such as automatic firmware upgrades

e  Supports remote printing from mobile devices with HP Smart App, see http://www.hpsmart.com

e  Economode for printing economically

e  Enables easy printing from desktop with HP Click, see http://www.hp.com/go/designjetclick

e Ink and paper usage information available from the Embedded Web Server, see Access the Embedded Web
Server on page 17

e  Supplies information, troubleshooting, and firmware updates available from the HP Utility, see Access the
HP Utility (Windows only) on page 18

e  Access to the online HP Support Center, see HP Support Center on page 97

° HP Support Assistant supports the printer, see HP Support Assistant on page 63

e  (Compatible with the HP Applications Center — Poster App, see

http://www.hpapplicationscenter.com

*Windows only

Main components

Hardware features of your printer.

Front view

Overview of the front of the printer's main hardware components.

4 Chapter 1 Introduction ENWW
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1. Multi-sheet tray
Front panel

Main door

2

3

4. Ink cartridges
5 Carriage
6

Stand

Rear view

Overview of back of the printer's main hardware components.
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1. Paperroll
Communication ports
Power button
Multi-sheet tray

Fast Ethernet port, to connect to a network

o vk~ W N

Hi-Speed USB device port, to connect a computer

Turn the printer on and off

The power key is located at the back of the printer.

The power key can also be used to put the printer into sleep mode. See Configure power button mode

on page 18. The key is illuminated when the printer is on. It flashes when the printer is in transition between on
and off.

ENWW Turn the printer on and off



However, if you plan to store the printer for a long period or the power key does not seem to work, you are
recommended to unplug the power cord.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printhead.

[%9 NOTE: When the printer has not been used for a certain period of time (the default time is determined by
Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's front-panel
display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To
change the sleep mode time, see Change the sleep mode setting on page 18.

Front panel

Located on the front left of the printer there is a touch-sensitive screen with a graphical user interface. Fromit,
you can print, view information, change settings, and perform calibrations and tests, etc.

The front panel also displays alerts (warning and error messages) when needed.

6 Chapter 1 Introduction ENWW
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Paper Source Setup

1. Dashboard icons

The front panel dashboard lets you access the icons on the display, check the status of the printer, or monitor
and manage current and scheduled printer tasks.

Tap or swipe down the tab at the top of a screen to open the dashboard:
e  Tap[BH to change printer settings.

e Tap to view ink information.

o Tap [ to view printhead information.

e Tap to view connectivity status information and to perform network configuration. If a network cable is
connected, &4 is displayed instead.

[%”Y NOTE: Itis not possible to use wireless and wired network connections simultaneously.

e Tap to view information about Wi-Fi Direct.

e Tap to view information and configure ePrint to print from a computer or mobile device, sending an
email to the printer.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. See how
to configure the power management: Configure power button mode on page 18.

2. Home screen dynamic icons

ENWW

The front panel has a central area to display dynamic information and icons.

The following items are displayed when you tap the paper icon :

e Tap to load, unload, and change options for roll paper.

e Tap to change options for the multi-sheet tray, or to activate it.
e Tap m to load, unload, and change options for single sheets.

To change the printer settings or print reports, use the options available in: .

Front panel



%’9 NOTE: The active paper source is indicated by a slightly larger icon, with a white tick in a green circle: .

3. Fixed icons

On the lower side of the screen up to 3 fixed icons can be seen at different times. Normally they are not all
displayed at the same time.

o Tap @) to return to the home screen.
o Tap | to view help about the current screen.

e Tap to go back to the previous screen without discarding changes.

Printer solutions

Drivers and other tools are provided with your printer to raster, review, print locally/remotely, and access support
if required.

The following software is available for your printer at: http://123.hp.com or http://www.hp.com/go/
DesignJetStudio/software:

° Driver for Windows and Mac

e  The HP DesignJet driver that offers a preview, which enables you to see a basic preview of how your job will
print

yaQ [ e | em
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e  The Embedded Web Server that allows you to manage the printer from a remote computer, update the
printer's firmware and change various printer settings, etc.

@ HP DesignJet

Embedded Web Server Search E

Home  WebServices Metwork Tools  Settings

Energy Save Mode Web Services Printer Update Estimated Cartridge Le...
A Secune (oOReClon 1 A secune Conneclion & A secune Connection &
sequiren, K 15 enable. re e sequren, (X 1 enatle. » i ﬁ i
o Eo o .o
et bewols may wery.

Network Summary Print Quality Toolbox Wireless Setup Wizard Wi-Fi Direct
Aseen f—
requred.

Aseoure connedtion s Astome
required. CBok 1o enable. required.

See Access the Embedded Web Server on page 17.

e  The HP Utility (Windows only) that allows you to manage the printer from a remote computer:

—
@ HP Designiet Uty
Devices B Overveew Supphes Sugpont Asmn 9?7
O Do T e e Supphes e
* wr
1 Desigriet T30 Y- Estmated ik kevets (%) © Y prrter st

P Dosoniet 1800
.

P Dasilet T30
* wn
Frishact rumar

oty ety BNE i by by

Pages st

See Access the HP Utility (Windows only) on page 18.

[% NOTE: New versions of all printer software can be expected to appear from time to time. In some cases, when

you receive your printer there may already be later versions available on HP's website of some of the software
provided with it.

Mobile Printing

Your printer can be connected to the Internet and the Web, providing various benefits.

e  Automatic firmware updates (see Firmware update on page 62)

e  Print on HP printers from almost anywhere with HP Smart App
e  Print on HP printers from almost any device, including smartphones and tablet computers
To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hp.com/go/designjetmaobility.

Enable email printing

Turn on Web Services to allow your printer to communicate securely over the Internet with web-connected
printing services.

ENWW Mobile Printing
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1. Make sure that your printer is correctly connected to the Internet.

2. Enable Web Services during initial setup of the printer, or later by touching @ on the home screen and
following the instructions on the front panel. The printer may need to restart if it has updated its firmware.

3. Retrieve the printer's email address by touching on the home screen at any time.

4.  Thisis an optional step: If you are the printer administrator, log in at HP Smart (http://www.hpsmart.com)
to customize your printer’s email address or manage user access for remote printing.

For the latest information, support, and terms of use of the HP Smart see http://www.hpsmart.com. You can
also benefit from automatic firmware updates after following this setup.

Reports

The internal prints give various kinds of information about your printer. They can be requested from the front
panel.

Before requesting any internal print, check that the printer and the paper are ready for printing. The loaded paper
should be at least A4 portrait—210 mm ((8.27 in)) wide—otherwise the print may be clipped.

To print any internal print, tap , then scroll down to Reports and tap it, then select the internal print you want.
These are some of the prints available:

e  Demo prints that show some of the capabilities of the printer
—  Drawing demo
—  Rendering demo
—  GISmap demo

e  Userinfo prints

° Printer status report

Print quality report

e  Web access test report

e  Network configuration
o  Wireless test report

e Joblog

e  Errorlog
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2 Connecting the printer

Printing has never been easier, and your printer comes with various options for connecting to help you do so.

Choose which connection method to use

Your printer can be connected via Wireless, Gigabit Ethernet, or Hi-Speed USB.

Table 2-1 Connectivity methods

Step 1: Connect the printer to your network:

OPTION A
_D Using your mobile

If you connect a new printer, the HP Smart App ( available in
App Store and Play Store) can lead you through the process.
Please note that both printer and device must be connected
to the same Wi-Fi

-l

OPTION B

Use the front panel to choose one of these
options:

Connect to Wi-Fi

- If the printer is new, just follow the steps in the
front panel

- Printer and device must be connected to the
same Wi-Fi

Connect to Ethernet

If printer is new, connect the Ethernet cable
before turning it on

Connect to USB

Use Hi-Speed USB cable, male USB type A to
male USB type B

Step 2: Set up your device:

- Printer and devices must be connected to the same
network

- If required you can find your printer's IP by scrolling down
from the top of the screen

Automatic setup

Go to http://123.hp.com to download the HP
software and driver

For advanced setup or additional software:

Go to the support page for your printer series:
http://www.hp.com/go/DesignJetStudio/
software

[% NOTE: If you connect an Ethernet cable, it turns off the wireless capability of the printer.

ENWW

Choose which connection method to use
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[%’ NOTE: Wireless connections can be affected by the location of the network router and the device. In order to
improve a wireless connection:

1. Position the wireless access point in a more central position within the work place.

2. Place the wireless access point away from dense materials. Metal, concrete, double thick walls are the hardest
to penetrate, wood and plasterboard are easier. Consider this when you position the printer.

3. Change the wireless channel to one that is not being used. Preferably 1, 6, or 11, as these are non-overlapping
channels.

4. Extend the range of the wireless network with the use of a simple wireless extender or add more wireless
access points.

1. Connect the printer to your network

If this is the first time you are using the printer: Connect your printer by using the HP Smart App.

[%r NOTE: Use the HP Smart APP for printer Setup during initialization. If your printer is not new and you want to
use the HP Smart App you need to go to the Default Configuration mode.

Set up using the HP Smart App

You can use the HP Smart App to set up the printer on your wireless network.

The HP Smart App is supported on i0S, Android, and Windows devices. For information, see Print from Apple i0S
or Android with HP Smart App on page 30.

1.

2.
3.

If you are using an i0S or Android mobile device, make sure that Bluetooth is turned on. (HP Smart uses
Bluetooth to make the setup process faster and easier on i0S and Android mobile devices.)

[%F NOTE: The HP Smart App uses Bluetooth for printer setup only. Printing using Bluetooth is not supported.

Open the HP Smart App.

Windows: On the home screen, tap Set Up a New Printer and follow the onscreen instructions to add a
printer to your network.

or

Android: On the home screen, tap the +icon and then tap Add Printer. Follow the onscreen instructions to
add a printer to your network.

Set up the printer on your wireless network

12

On the front panel, use the Wireless Setup Wizard or Wi-Fi Protected Setup to set up wireless communication.

1.

2.
3.
4.
5.

From the front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and then
tap §R

Tap B8

Tap Wireless Settings.

Tap Wireless Setup Wizard or Wi-Fi Protected Setup.

Follow the front panel instructions to complete the setup.

If you are already using the printer with a different type of connection, such as a USB connection, to change see
Mobile Printing on page 30.
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2. Set up your device

Prepare your printer with the correct software for your device.

Install the software (Windows)

Make sure to connect the printer and computer or mobile device to the same network.

Download the software from http://123.hp.com or go to http://www.hp.com/go/DesignJetStudio/software.

Install the software (Mac 0S X)

Make sure to connect the printer and computer or mobile device to the same network.

Download the software from http://123.hp.com or go to http://www.hp.com/go/DesignJetStudio/software.

Add your printer
Add a printer to a network under Mac OS X.
A Go to System Preferences® Printers and Scanners, and then tap + to add a new printer.

e Ifyouinstalled the driver: Select the IP tab, enter your IP address, and select the protocol HP Jetdirect-
Socket. Tap Continue.

e  If youwant to use AirPrint: Choose your printer from the list of displayed network printers, and tap
Add. Then, in the Use menu, select Secure AirPrint or AirPrint, and then tap Add.

% TIP: To see the bonjour name on the front panel, open the printer's dashboard and tap the F3 or B8 icon.

Other options

There are other ways to connect your printer directly to a computer.

Connect a computer to the printer by USB cable (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer's built-
in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some
disadvantages that you should bear in mind.

e  Thecableis of limited length.
° It is more difficult to share the printer.
e  You cannot use Web Services.

e  You cannot use automatic firmware updates.

[%”f NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB
Implementor's Forum ( http://www.usb.org/) should be used with this printer.

Printer sharing considerations

Any other users sharing your USB-connected printer will be able to send print jobs, but will not be able to receive
information from the printer—which affects status reports, administration and troubleshooting.

% TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the
network. See Connecting the printer on page 11.
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3 Setting up the printer

Set automatic firmware updates, email notifications and driver preferences, and control access to the Embedded
Web Server.

Introduction

There are various printer settings that the printer administrator may wish to control as soon as a new printer is
assembled and ready for use.

Automatic firmware update

The printer can automatically check for a firmware update periodically.

See Firmware update on page 62

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server.

e  SMTP server: The IP address or hostname of the outgoing mail server (SMTP) that will process all email
messages from the printer. If the mail server requires authentication, email notifications will not work.

e  Printer email address: Each email message sent by the printer must include a return address, which does
not need to be a real, functional email address, but it should be unigue, so that recipients of the message
can identify the printer that sent it.

You can turn specific email notifications on or off by clicking Email alerts in the Embedded Web Server tab.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your
printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility, by the
printer driver and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.
To access alert settings under Windows:

e  C(lick Alert Settings in the Tools menu of the Embedded Web Server.

e  Right-click the HP DesignJet Utility's system icon, and click Alert Settings.

In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.
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| Alert settings *

Alert settings by printer:

HP Designjet T2500(15.87.217.169) IP(15.87.217.169) ~ |

| The alert notifications for this printer are ACTIVE. Alert dialogs of the
| following type will be displayed on your computer.

| Critical alerts: Always b
Nen-critical alerts: [ Mever v |
|
]
HP DesignJet T250 24-in(15.87 238.72) P (15.87.23872) ~

The alert notifications for this printer are ACTIVE. Alert dialogs of the
following type wall be displayed on your computer.

Critical alerts: Always b

Non-critical alerts: | While | am printing v

? T

Alternatively, you can choose when, if ever, to display critical or non-critical alerts.

To access alert settings under Mac OS X:

e  Open HP Printer Monitor preferences, select your printer, and then Customize Alerts, so that you can set
each individual alert to appear in specific cases and with a specific time interval.

+ B < 4 Printers Q-
Nam  Reload Details

o Customize Alerts

Cannectios
W Addres  Turn Monitoring Off
y PW Version "
| Seriaiumpe  Dignose
Diagnose All ViR

| _ Update Rules & Diagnose All
| Go to HP Utility

[

e  You can turn off alerts completely by unchecking the Show monitor status in menu bar box in the
Notifications tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the Notify
me when alert appears box (as below), the alerts will be available in the HP Printer Monitor, but will not pop
up in the Dock screen.

ann Preferences

™ Show manitor status in menu bar

|_| Notify me when alert appears |
> Al |
Critical only
Custom
Fatal |
Error
Warning |
Infarmation
Optimization |
List alerts in popup window |
Notified only
=) All active
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Control access to the Embedded Web Server

You can prevent users from modifying important device settings by setting a password in the Embedded Web
Server.

Users without the password can see only the Information tabs. Once set, the password is required to view or
change any parameters in the other tabs.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to
set color or paper-saving options.

To change default settings, click the Start or Search button on your computer’s screen (depending on your
version of Windows), then click Devices and Settings, Devices and printers or Print Management. Then right-click
your printer's icon and click Printing preferences or Set Printing Defaults. Any settings you change in the Printing
Preferences window will be saved as default values for the current user.

To set the default values for all the users of your system, right-click the printer’s icon again, click Printer
Properties, go to the Advanced tab, and click Printing Defaults. Any settings you change in the Printing Defaults
window will be saved for all users.
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4  Personalizing the printer

You can set your printer preferences such as language, sleep mode, firewall, and front panel brightness settings
etc.

Change the language of the front-panel display

Your printer includes many language options to choose from.
To change the language of the front-panel menus and messages:

If you can understand the current front-panel display language, tap then Preferences > language. Select your
preferred language.

Access the Embedded Web Server

Manage your printer remotely using an ordinary web browser running on any computer.

To access the Embedded Web Server on any computer, open your Web browser and type the IP address of your
printer.

You can see your printer’s IP address on the front panel, open the dashboard and tap [ or J&

To access the Embedded Web Server, you must have a TCP/IP connection to your printer. You can access the
Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a TCP/IP connection
(wired or wireless).

The first time you access the Embedded Web Server, the computer requests your username and password to
prevent unauthorized users from remotely configuring the printer, or viewing printer settings. The password is
required to change or view printer settings. By default the user is admin. The PIN is found behind the printer.

You can print the printer status report: Setup» Reports® Printer status report.

[%’ NOTE: The status report has the PIN. If your changed the initial PIN by default and forgot it, go to
Troubleshooting general printer issues on page 92.

The following browsers are known to be compatible with the Embedded Web Server:
e  Microsoft Internet Explorer 11 and later for Windows 7 and later

e  Apple Safari 8 and later for OS X 10.10 and later

e  Mozilla Firefox (latest version)

e  Google Chrome (latest version)

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot access
the Embedded Web Server on page 93.

Change the language of the Embedded Web Server

The default language is the same as your browser but if it is not supported, it will appear in English. You can
change it to any supported one.
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Embedded Web Server supported languages are English, Portuguese, Spanish, French, Italian, German, Polish,
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is a tab at the top right of the
window to select them from.

Access the HP Utility (Windows only)

Manage your printer from a computer with a USB, TCP/IP, or Wi-Fi connection.

The first time you access to the application you need to enter the printer information. Enter the printer's IP
address or hostname to add it to the printer list. Alternatively, select General search to find all HP DesignJet and
HP PageWide XL printers on your network.

e Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs > HP >
HP DesignJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the HP DesignJet
printers installed on your computer.

e  Whenyou select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

Change the language of the HP Utility

Choose from English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified
Chinese, Traditional Chinese, Korean, and Japanese.

e  Under Windows, the language will be adjusted to your regional language settings as defined in the
Windows Control Panel.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it automatically goes to sleep to save
power.

To change the time the printer waits before it goes into sleep mode, go to the front panel and tap , then
Power management > Sleep mode. Select the wait time you want.

Configure power button mode
You can set the printer to turn itself off or enter into sleep mode.

Goto , then Power Management » Power Button Mode and select the option you want.

To change the time that elapses before sleep mode, tap , then Power Management® Sleep Mode. You can set
a time between 5 minutes and the maximum time allowed by the current energy savings regulations.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external
interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

Change the auto-off setting

The printer can be set to turn the itself off automatically which is useful for power management control.
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For example, setting the printer's auto-off feature to 2 hours would turn the printer off after 2 hours of inactivity.
In this way, you can save more energy. However, the auto-off feature is automatically disabled when the printer is
connected to a network, to avoid inconveniencing network users.

If you are using a USB connection, you can set the printer to turn itself off completely after 2 to 12 hours of
inactivity. At the front panel, tap [l§§}, then Power Management > Auto-off.

Change the front-panel display brightness

The level of brightness displayed can be adjusted.

To change the brightness of the front-panel display, tap , then Preferences > Screen brightness and select the
value you want. Tap Done to set the value.

Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front
panel.

ENWW

From the Embedded Web Server: Select the Network tab.
From the HP Utility: You can access the Embedded Web Server through the HP Utility.

From the front panel: Swipe down the dashboard, tap then scroll down the menu and touch Network
setup.

The following options are available:

Print the start Guide to print the instructions
Enable/Disable wireless turns the wireless connection on or off.
Wireless setup wizard provides an easy way to connect to a wireless network.

Wi-Fi protected setup allows you to set up a connection with a wireless network using WPS (pushbutton or
pin) encryption.

View wireless details displays information about the wireless network

[P settings allows you to select the IP address -automatic or manual (Static)

Print Wireless test report print information about the wireless network

Print wireless network test runs diagnostic tests of wireless connectivity

Ethernet settings view and print ethernet details

Advanced setup

e Link speed sets the speed at which data are transmitted over the network. The default is Automatic.

e |Psettings allows you to view or change the IP address, subnet mask, default gateway, and DNS
address.

e  General settings
o Hostname allows you to change the hostname.
o  Proxy settings allows you to change the proxy settings

o  Bonjour name allows you to change the bonjour name

Change the front-panel display brightness 19



e  Restore network defaults

Configure firewall settings

Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides simple
control of IP addresses that are allowed access.

99

B NOTE:  In addition to firewall protection at the network layer, the printer also supports open secure sockets
layer (SSL) standards at the transport layer for secure client-server applications, such as client-server
authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP traffic. Firewall
policy pages are accessed through the Embedded Web Server and displayed by your Web browser. After a policy
is configured, it is not activated until you click Apply in the Embedded Web Server.

Creating and using firewall rules

Control IP traffic and allow or drop IP traffic based on IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those
addresses and services.

Create a firewall rule

Set up a new rule from the Embedded Web Server.

1. Open the Embedded Web Server.

2. Tap the Settings tab, then Firewall» Firewall Rules.
3. Select Enable Firewall.
4.

Tap E4, and then follow the onscreen instructions.

[%,/r NOTE: After you tap Apply, the connection to the Embedded Web Server might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Change the priority of firewall rules
You can move a rule up or down in the priority list.
1. Open the Embedded Web Server.
2. Tap the Settings tab, then Firewall» Firewall Rules Priority.

3. Select the priority from the Rule Precedence list, with 10 having the highest priority and 1 having the lowest
priority.

4.  Tap Apply.
Change firewall options
Options can always be edited at a later date.
1. Open the Embedded Web Server.
2. Tap the Settings tab, then Firewall» Firewall Options.
3. Change whatever options you wish, then tap Apply.
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[% NOTE: After you tap Apply, the connection to the Embedded Web Server might be temporarily disrupted for a
short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled
again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Reset firewall settings

Restore the printer’s network settings to reset to factory defaults.

Limitations to rules, templates, and services
There is a limit per item that can be created and stored at any one time.

Table 4-1 Limitations per item

Item Limit

Maximum number of rules 10 (one default rule)
Maximum number of address templates 12

Maximum number of user-defined address templates 5

Maximum number of services you can add to a user-defined service template 40

NOTE: The predefined All Services template is not subject to this limitation and includes all services
supported by the print server.

Maximum number of services you can add to the policy 40

NOTE: For a given rule, only one address template and one service template can be added.

Maximum number of service templates in the policy 10

Maximum number of user-defined custom service templates 5

Reset network settings
The administrator password and network settings can be restored.

Go to the front panel, swipe down the dashboard and tap {\ﬁ} then scroll down the menu and tap Network setup
> Restore network settings

Ej?"” NOTE: Print the network configuration page and check that the network settings have been reset.

[%’f’ NOTE: Resetting the printer's network settings also resets the printer’s firewall settings.

Embedded Web Server security settings

Set a password and create an administrator account to control access and changes.

From the Embedded Web Server menu, tap Settings» Security.

Password settings:

You can set a password to prevent unauthorized users from remotely configuring the printer or viewing printer
settings from the embedded web server (EWS). Once set, this password is required to change or view many
printer settings from the EWS.

To disable the password, leave the boxes blank.
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Administrator password:

You can control access to the printer by specifying an administrator account to control access to the Embedded
Web Server. You can customize your printer by enabling or disabling the features available. After a feature has
been disabled, it is not available from the EWS or printer's front panel.
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Paper handling

To print you can load rolls, single sheets, or use the multi-sheet tray. View paper information and use the
printer's cutting tool.

General paper-loading advice

You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of single
sheets from the multi-sheet tray (if you have one). Switching from one to another is automatic.

A CAUTION: If your model has a stand, make sure the printer wheels are locked (the brake lever is pressed down)
to prevent the printer from moving.

A CAUTION:  All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be loaded in landscape
orientation.

X TIP:  For photo paper wear cotton gloves to avoid transferring oils onto the paper.

A CAUTION: Keep the bin closed throughout the loading process.

Load a roll onto the spindle

ENWW

Rolls of different widths can be loaded onto the printer.

1. Remove the spindle from the printer.

A WARNING! Do not insert your fingers into the spindle supports during the removal process.

2. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a
new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the
end of the spindle.

-

p—

General paper-loading advice
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3. Iftherollis long, rest the spindle horizontally on a table and load the roll on the table.

4.  Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the
roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the
correct orientation.

[%9 NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.

<

-y

Ensure both ends of the roll are as close to the spindle stops as possible.

5. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

5 A
a0

6. Ensure the blue paper stop is pushed in as far as it goes. Check that there is no space between the roll and
the stops at both ends.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Accessories

on page 64.

Load a roll into the printer

Before you start this procedure, you must have a roll loaded on the spindle.

See Load a roll onto the spindle on page 23.

1. From the front panel, tap [}, then [i§-
This step is optional: if you just start feeding in roll paper, the printer recognizes that you want to load a roll.

2. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as viewed
from the front of the printer.
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3. Ifthe edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.

4. Insert the edge of the paper into the printer.

AWARNING! Do not push your fingers inside the printer's paper path.

5. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it beeps, and feeds in the paper automatically.

6.  The front panel prompts you to select the paper category and type.

If you do not see your paper type in the front panel, tap More paper types. If you still cannot find your paper
type in the whole list, see Paper type is not in the driver on page 68..

7. The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow the
instructions on the front-panel display.

[%”Nf NOTE: If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded
successfully on page 66 .

Unload a roll

If there is paper on the roll, you can unload it from the front panel.
Tap [, then [l then Unload roll. Afterwards, the multi-sheet tray will become the default active paper source.

If the end of the paper is no longer attached to the core, the front panel asks you to unload the roll manually.

After unloading, the multi-sheet tray is the default active paper source.

Load a single sheet

Roll paper and single sheets use the same input slot in the printer.

[i?’”f} NOTE: If you have a multi-sheet tray see Use the multi-sheet tray on page 26.
B NOTE:  Sheets of width 329 mm ((12.95 in)) or less should be loaded from the multi-sheet tray.

1. Atthe front panel, tap [l then [}

2. Ifarollis already loaded, you have to wait while it is automatically unloaded.

3. Opentheroll cover.

4.  Select your paper category and type. If you do not see your paper type in the front panel, tap More paper
types. If you still cannot find your paper type in the whole list, see Paper type is not in the driver
on page 68.
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5. When prompted by the front panel, insert the sheet into the right-hand side of the input slot.

AWARNING! Do not push your fingers inside the printer's paper path.

6.  Align the sheet with the blue line.

7. Tap OK onthe front panel to feed the paper into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

8.  The printer checks the alignment and measures the sheet.

[% NOTE: Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it.

[%9 NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be
loaded successfully on page 66 .

Unload a single sheet

Sheets are unloaded from the front of the printer.

To unload a sheet, go to the front panel and tap [l then ] then Unload.

Either catch the sheet manually or allow it to fall into the bin.

After unloading, the multi-sheet tray is the default active paper source.

Use the multi-sheet tray

You can load multiple sheets and ease single sheet printing.
1. Ifnorollis loaded or the roll has run out of paper, the multi-sheet tray is active by default.

Alternatively, at the front panel, tap [, then[&]
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2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and the
second extension for A3 paper.

N ;

&
-—

N

3. Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are all of

the same size.

4. Adjust the tray to fit the width of the paper.

&4
.

View information about the paper

Tap the icon of the active paper source.

The following information is displayed on the front panel:
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e  Paper type you have selected
e  Roll or sheet status
e  Width of the paper

If no roll and no single-sheet paper is loaded, the message Out of paper is displayed.

Maintain paper
Always protect your paper and sheets to print at the highest quality.
e  Storerolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e  (leaninput and output platens

e  Always keep the top cover of your printer closed

[%r NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 80.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where
time is of higher importance or when you need to be sure ink is dry before handling.

Tap [&&]], then Printer preferences > Print retrieval > Select drying time. You can select:
e  Extended, to set a longer than recommended time to ensure ink is completely dry
e  Optimized, to set the default and recommended time for your selected paper (this is the default setting)

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION: If theink is not dry when the print is removed it could leave ink in the output tray and marks on the
print.

[*_'%f“ NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to
the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then
performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the
paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

You can change the cutter option to suit your requirements for each print job.

To turn the printer's paper cutter on or off, go to the front panel and tap , then Print Settings and change the
cutter option.

The default setting is On.

r.%? NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on
loading and unloading rolls.

X TIP: To cut roll paper while the automatic cutter is disabled, see Form feed and form feed and cut on page 29.
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Form feed and form feed and cut

You can advance the paper with, or without cutting it.

Go to the front panel and tap , then Form feed. There are 2 options: Form Feed and Form feed and Cut. The

Form feed option advances the paper without cutting it. Form feed and cut advances the paper and makes a
straight cut across the front edge. There are at least two possible reasons why you might want to do this:

e  To trim the leading edge of the paper if it is damaged or not straight.

e  Tofeed and cut the paper when the automatic cutter has been disabled.

[%f NOTE: The printhead is serviced after each print, and the paper cannot be cut until the process completes, so
you may notice a delay.

A CAUTION: Remove the cut piece from the output platen. If strips or short prints are left on the output platen,
the printer could jam. Check also that there are no pieces of paper in the cutter guide.

[%”f NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 80.
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6 Printing

Printing has never been easier or more flexible. Print from computers and mobile devices with the use of a
variety software, customizable options and advanced settings.

Mobile Printing

You can print to your printer from many mobile devices using direct printing by connection to the same network.

Print from mobile devices

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple
steps.

e  AppleiOS printing is enabled through AirPrint, which comes pre-installed in iOS devices.

e  For Android printing, install the HP Print Service Plugin from Google Play (if you do not have it already pre-
installed in your mobile device).

For more information, see http://www.hp.com/go/designjetmaobility.

Print from Android
Install and enable the HP Print Service App from Google Play.

You can download the App from: https://play.goodle.com/store/apps/details?id=com.hp.android.printservice, if it
is not already installed in your device. You must have Android Lollipop 5.0 or later.

1. Open the document or photo you want to print, and tap the menu icon, then Print.
2. Choose your printer from the list.

3. Check the print settings, then tap Print.

i0S (iPhone, iPad) with AirPrint

Printing with AirPrint is simple, all you have to do is make sure your device and printer are operating on the same
network.

Follow the steps below:
1. Choose your content. Open the document or photo you want to print, then tap the share button.
2. Select printicon.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed documents.

Print from Apple iOS or Android with HP Smart App

Connect and print wirelessly from an Android or Apple smartphone or tablet.

Download from the Apple Store (https://itunes.apple.com/us/app/hp-all-in-one-printer-remote/id4692849077
mt=8) or from Google Play (https://play.google.com/store/apps/details?id=com.hp.printercontrol).
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1. OpenHP Smart App and browse for the document or photo you want to print.
2. (o to Edit to adjust the output if necessary.
3.  TapPrint.

With HP Smart App you can also print even when your mobile device and your printer are not in the same
network.

Remote Printing feature can be enabled either during the initialization process if you choose to do it with HP
Smart. Otherwise, it can be enabled later.

Ej?’y NOTE: Inside HP Smart, enable your printer for remote printing by pressing the printer icon. Check the option
Print Anywhere in printer options and follow the steps in the app.

£Rk)

[ NOTE: Remote Printing feature requires that device and printer are connected to Internet.

9

[ NOTE: Remote Printing feature requires to have an HPSmart.com account. If you don "t have an account, HP
Smart will guide you to create one.

If Remote Printing feature is configured in your printer, the owner of the printer can manage the remote printing
access to share the printer with other users:

1.  OpenHP Smart App, select your printer and press the printer icon.

2. Ifyou are the owner of the printer, you will see an option called Manage Print Anywhere. Tap it.

Manage Print Anywhere

Share remote access to the printer by email.

Users Access

3. Decide whether to share the printer with others or grant/revoke access individually.

Ej?f)y NOTE: The owner of the printer is the HPSmart.com user that has registered the printer in their account.

Print using Wi-Fi Direct

With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable device
—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct

There are essential prerequisites to using Wi-Fi Direct.

e  Make sure your computer or mobile device has the necessary software.
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e Ifyou are using a computer, make sure you have installed the HP printer software.

e |f you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and
then install the printer software. Select Wireless when prompted by the printer software for a
connection type.

e Ifyouare using a mobile device, make sure you have installed a compatible printing app. For more
information, visit the HP Mobile Printing website at http://www.hp.com/go/mobileprinting. If a local version
of this website is not available in your country/region or language, you might be directed to the HP Mobile
Printing website in another country/region or language.

e  Make sure Wi-Fi Direct for your printer is turned on.
e  Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

e  Wi-FiDirect can be used while the printer is also connected either to a computer using a USB cable orto a
network using a wireless connection.

e  Wi-FiDirect cannot be used to connect a computer, mobile device, or printer to the Internet.

Turn on Wi-Fi Direct
You can turn on Wi-Fi Direct directly from the front panel, or alternatively from the EWS.

1. From the printer front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and
then tap [iE]}

2. Tap[El
3. If the display shows that Wi-Fi Direct is Off, tap Wi-Fi Direct and then switch it on.

4.  You can also turn on Wi-Fi Direct from the EWS. For more information about using the EWS, see Access the
Embedded Web Server on page 17.

Change connection method

You can change the Wi-Fi Direct connection method, and choose between automatic and manual.

1. From the printer front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and
then tap [iE}

2. Tap[El)

3. Tap Connection Method and then select Automatic or Manual:

e |f Automatic was selected during Wi-Fi Direct setup on the printer, the mobile device automatically
connects to the printer.

e |f Manual was selected during the Wi-Fi Direct setup on the printer, acknowledge the connection on
the printer display or enter the printer PIN on your mobile device. The PIN is provided by the printer
when a connection attempt is made.

Print from a wireless-capable mobile device that supports Wi-Fi Direct

Make sure you have installed the latest version of HP Print Service Plugin on your mobile device.

[%,/r NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.
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Make sure you have turned on Wi-Fi Direct on the printer.

Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with the
mobile device.

From your mobile device, select a document from a print enabled application, and then select the option to
print the document.

The list of available printers appears.

From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP DesignJet
Studio Printer series (where ** are the unique characters to identify your printer), and then follow the
onscreen instructions on the printer and your mobile device.

Print your document.

Print from a wireless-capable mabile device that does not support Wi-Fi Direct

Make sure you have installed a compatible printing app on your mobile device.

For more information, visit http://www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1.
2.

3.

4.
5.

Make sure you have turned on Wi-Fi Direct on the printer.

Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation provided
with the mobile device.

[’_ﬁ”r NOTE: If your mabile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

From the mobile device, connect to a new network. Use the process you normally use to connect to a new
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such
as DIRECT-**-HP DesignJet Studio Printer series (where ** are the unigue characters to identify your
printer).

Enter the Wi-Fi Direct password when prompted.

Print your document.

Print from a wireless-capable computer (Windows)

To use Wi-Fi Direct, your computer must support Wi-Fi.

This example is for Windows 10.

1.

2.
3.

Go to Start » Settings » Devices » Printers & scanners, and tap Add a printer or scanner to add the Printer.

’L%y NOTE: If your printer is not listed, you may need to wait until the Show Wi-Fi Direct printers link appears.

Identify your Wi-Fi Direct, its name starts with the suffix DIRECT-XX-HP... followed by the model name.

Depending on the Wi-Fi Direct connection method configured for your printer, you may need to accept the
connection by tapping the message in the front panel.

When connection is established, Windows downloads the appropriate driver and adds the printer to your
system.

Once added, the printer is ready for use with any Windows application.

Easy printing with HP Click

HP Click is an easy-to-use tool designed for people who want a simple way of printing on large format printers.
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Ideal for a broad range of graphics and technical applications, including posters, roll-up banners, info-graphic
presentations, maps, and CAD documents. See http://www.hp.com/go/clickDesignJet.

Printing from an application using a printer driver

This is the traditional way of printing from an application.

The correct printer driver must be installed on the computer (see Connecting the printer on page 11), and the
computer must be connected to the printer by network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings

Advanced print settings can be used when the defaults do not meet your requirements.

The rest of this chapter explains the various print settings that you can use. These methods offer a relatively
large number of settings in order to satisfy all requirements.

¥ TIP:  In general you are recommended to use the default settings unless you know that they do not meet your
reguirements.

TIP: If youintend to reuse a particular group of settings repeatedly, you can save those settings under a name
of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows
printer driver.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

You can select the options: Best, Normal and Fast. If you select Fast, you can also select Economode, which
consumes less ink, increases printing speed even further, but reduces print quality. Economode can only be
selected from the advanced options.

There are supplementary custom options that may have an effect on print quality: Maximum detail. See High-
quality printing on page 38.

e Inthe Windows driver dialog: Go to Print quality, then depending on the selection, more specific options
such as Economode or Maximum detail which can only be selected from the advanced options.

e  Inthe Mac 0S X Print dialog: go to the Paper/Quality panel and look at the Quality Options section. If you
select Standard quality options, you will see a simple slider with which you can select speed or quality. If
you select Custom quality options, you will see the more specific options described above.

[%,/r NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

993

[ NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received
(even if they have not started to print yet).

Select paper size

The paper size can be specified and the document can be rescaled if necessary.

[%9 NOTE: The paper size specified should be the paper size the document was created at. It is possible to rescale
the document to a different size for printing. See Rescale a print on page 36.
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e Inthe Windows driver dialog: Select the paper size from the Document Size list.

e Inthe Mac OS X Print dialog: Select your printer from the Printer list, then select your paper size from the
Paper Size list.

[%”r NOTE: If your application offers no Page Setup dialog, use the Print dialog.

[i;’/( NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.

Use the Windows printer driver
You can create and save custom paper sizes to suit your requirements.
1. Go to Basic > Document size.
2. Open the drop-down list, scroll down to the Custom section and tap on Create.
3.  Enter the name, unit, and size of the new paper custom size.
4.  Tap the Save button.
Custom paper sizes created with the printer driver have the following characteristics:
e  The paper size is permanent and does not disappear if the driver is closed or the computer is turned off.
e  The paper size is local to the printer queue and not seen from other printer queues in the same computer.

e InDomain server networks, the paper size is local to the computer and not seen from other computers
sharing the printer queue.

e InWorkgroup networks, the paper size is shared among all the computers that share the printer queue.

e |f the printer queue is deleted, the paper size is deleted with it.

Use Windows forms
Unrestricted users can create a new Windows form.
1. From the Start menu or the front panel, tap Printers > File, and select Server Properties.
Windows 7: From the Start menu or the front panel, tap Devices and Printers, then Select Printer.
2. Inthe Forms tab, check the Create a new form box.
3 Enter the name and dimensions of the new paper size. Leave the margins as 0.00.
4.  Tap the Save form button.
5 Go to the printer driver and select the document size.
6.  Select your new paper size from the group of Custom sizes.
Paper sizes created with Windows forms have the following characteristics:
e  The paper size is permanent and does not disappear if the driver is closed or the computer is turned off.

e  Restricted users cannot create paper forms. The manage documents role in the Windows Active Directory is
the minimum required.
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e  The paper size is local to the computer and is seen in all the printer queues created on the computer that
support paper that size.

e If aprinter queue is shared, this paper size appears in all the client's computers.

e [faprinter queue is shared from another computer, this paper size doesn't appear on the driver’s
document size list. A Windows form in a shared queue must be created in the server.

e [fthe printer queue is deleted, the paper size does not disappear.

Use Mac 0S X printer driver
You can manage paper customs sizes from the driver.
1. Goto the Print dialog.

2.  Select Paper Size» Manage Custom Sizes.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper.
However, you can change this behavior in the following way:

e  Inthe Windows driver dialog: Select the correct option in the Margin layout area.
e Inthe Mac 0S X Print dialog: Select the Margins/Layout panel.
At least some of the following options appear:

e  Standard or Use application settings. Your image will be printed on a page of the size you have selected,
with the default margin between the edges of the image and the edges of the paper. The image should be
small enough to fit between the margins.

e  Oversize. You should load paper that is larger than the size you selected in the application or driver. If you
cut off the margins after printing, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper. This is useful when you want your image to
cover the whole area of the paper.

e  (lip Contents By Margins. Your image will be printed on a page of the size you have selected, with the
default margin between the edges of the image and the edges of the paper. In this case, if the image is the
same size as the page, the printer assumes that the extreme edges of the image are either white or
unimportant, and do not need to be printed. This may be useful when your image already contains a
border.

Print on loaded paper
You can print a job on whichever substrate is loaded in the printer.
e Inthe Windows driver dialog: Select Use printer settings in the Paper Type option of your printer driver.

e  Inthe Mac 0S X Print dialog: Select the Paper/Quality panel, then in the Paper Type drop-down list, select
Any.

299

B NOTE:  Use printer settings is the default Paper Type selection.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally
larger). This may be useful:
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If your software does not support large formats

If your file is too large for the printer's memory; in which case you can reduce the paper size in your
software and then scale it up again using the front panel option

You can rescale an image from the Windows driver dialog: Go to the Advance options > Scale.

By selecting a paper size, the image size is adjusted to the paper size you have selected. For example,
if you have selected ISO A2 and you print an A3-sized image, it is enlarged to fit the A2 paper. If the
ISO A4 size is selected, the printer reduces a larger image to fit the A4 size.

The percentage of actual size option enlarges the printable area of the original paper size by the
percentage indicated, and then adds the margins to create the output paper size.

In the Mac 0S X Print dialog: Select the Paper Handling panel, then Scale to fit paper size, and select the
paper size to which you want to scale the image. If you want to increase the size of the image, make sure
that the Scale down only box is unchecked.

If you are printing to a single sheet, you must ensure that the image fits onto the sheet, if not the image will be

clipped.

Preview a print

If you preview a print on the screen you can check the layout before you print, which may help avoid paper and
ink wastage.

Print a draft

To preview a print under Windows, you have the following options:

Use the HP Print Preview application:

Check the Show preview before printing box, which you can find in the right bottom corner of the
driver dialog. Click Print, then wait a few seconds for the HP Print Preview application to be launched.

Check that the job preview is as you wanted, and if it is, click Print. If it isn't as you wanted, then
modify the Print Preview options and check again, or click Cancel.

[17? NOTE: You can readjust the driver settings before you try again.
[i;’/f NOTE: The Show preview before printing box appears in the driver dialog only if HP Print Preview is

installed in your computer. If not installed, a download link is displayed.

Use your application's print preview option.

To preview a print under macQS, you have the following options:

Use your application's print preview option.

There is no Preview button at the bottom of the Print dialog box in the latest versions of mac0S. A
print preview is always shown at the upper left of the Print dialog box for most applications.

Choose the HP Print Preview option from the PDF menu at the bottom of the Print dialog box. The
print preview is displayed by a separate HP Print Preview application.

You can specify this to save time and cost.

In the Windows driver dialog: Go to Print quality and select Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings:
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e Inthe Windows driver dialog: Go to Print quality, set the guality level to Fast and check the Economode box.

e Inthe Mac 0S X Print dialog: Go to the Paper/Quality panel and move the print-quality slider to the extreme
left (Speed).

High-quality printing
For unrivaled image quality.
e Inthe Windows driver dialog: Go to Print quality and select Best.

e  Inthe Mac 0S X Print dialog: Go to the Paper/Quality panel and move the print-quality slider to the extreme
right (Quality).

If you have a high-resolution image
You can improve print sharpness when using glossy paper.

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options), print sharpness may be improved by selecting the Maximum Detail option.

This option is available only if you are printing on photo paper and you have selected Best print quality.

999

= NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the
amount of ink used.

Use paper economically
You may be able to save some of your roll paper by removing blank areas and/or by image rotation.
e |nthe Windows driver dialog: Check the Remove blank areas box.
You can also select one of the Rotation options.

e Inthe Mac OS X Print dialog: Select Finishing panel ™ Remove Blank Areas.

Use ink economically
There are some recommendations you can follow to save ink.

° Check the print preview on your computer before you print and avoid wasting paper on prints containing
obvious mistakes. See Preview a print on page 37.

e  Fordraft prints use plain paper, select Print quality, then Fast. For more economy, select Economode.

e  C(lean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount of
ink.

e  Leave the printer permanently turned on so that it can maintain the printhead in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done,
the printer may need to use much more ink later to maintain the printhead.

e  Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some
ink, and its frequency is related to the number of passes made by the printhead.

Color management

Your printer has been engineered with advanced hardware and software features to ensure predictable and
dependable color results.
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e  State-of-the-art HP printheads and HP inks

e  Dedicated color resources for most available paper types

Color management options

Reproduce colors as accurately as possible on all devices. When you print an image, you see very similar colors to
the image on your monitor.

Color management is highly dependent on the paper type loaded on the printer, so take care to select the correct
preset for the paper type used. The color management options for your printer can be selected from the Color
options section in the Windows driver dialog. In some applications you can make the choice in the application
itself. Consult HP Support Center on page 97 for information about how to use the color management options

in your application.

e  Application-Managed Colors: Your application must convert the image colors to the color space of your
printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and
paper type.

e  Printer-Managed Colors: Your application sends the image to the printer without any color conversion, and
the printer converts the colors to sRGB. This source profile emulates the characteristics of the average
computer monitor. This standard space is endorsed by many hardware and software manufacturers and
has become the default color space for many scanners, cameras, printers, and software applications.

Printer color management is completed using a set of stored color tables. ICC profiles are not used. This
method can produce very good results with supported HP paper types.

Printing in grayscale or black-and-white
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There are a number of ways to convert all the colors in your image to shades of gray.
e Inyour application program: Many applications provide this option.

e Inthe Windows driver dialog: In the Color mode selection, tap Print in Grayscale. Only black ink is used to
print, except if the paper loaded is glossy, in which case colored inks are used to compose the gray shades.
You can also select Print in pure black and white for black and white output only, with no gray shades. In
this case only black ink is used to print. The Print in pure black and white option is not supported when you
print on glossy paper.

e Inthe Mac OS X Print dialog: Go to the Color Options panel and from the Mode drop-down list, select
Grayscale. Only black ink is used for printing, unless the paper loaded is glossy, in which case the other inks
are used to compose gray shades. You can also select Pure black and white for black and white output only,
with no gray shades. In this case, only black ink is used for printing. The Print in pure black and white option
is not supported when printing on glossy paper.
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7 Practical printing examples

Step by step examples to print drafts, projects, presentations etc. to help you follow correct procedure with your
jobs.

Print a draft for revision with the correct scale

Page size and orientation may not always be set as you require. This can be altered.

Using Adobe Acrobat

Print a revision draft with the correct scale.

1. Inthe Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check
the page size.

b B e ket

]

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

[% NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button.

4.  Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom
paper size, follow the instructions in Custom paper sizes on page 35.

5. Select Rotation, then Autorotate.

6.  Click OK, and check that the print preview in the Print dialog box seems correct.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe
Acrobat Pro

Set up for a multipage job is a quick and simple process.
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Using a raster driver

You can print a multipage job from Adobe Acrobat.

1. Openamultipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the
latest version).

2. Click File > Print.
3. Select the printer and driver.

4.  Check the Choose paper source by PDF page size box.

3
c

Pripter: HF Designlet w Properties Aghvanced
Copies: 1 : [ Printt in grayscale (black and white)
Pages to Print Comments & Forms

®an Document and Markups ~

() Current page -
Summarize Comments

O Pages | - 179
* More Options Decurnent: .3 x 11.7in

827 % 11,69 Inches

Page Sizing & Handling @

[ size | (35 Poster [E] Munipte [] Bookiet

OFit

®) Actual size
1O Shrink oversized pages @
~) Custom Scale: 100

[ Choose paper saurce by PDF page sige

Orientation:

®) Auto portrait/landscape
O Portrait

) Landscape

Page 1.of 187

Page Setup... Print Cancel

5. Adjust other properties in the driver properties window, as required.
6.  Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Print a document with the correct colors

Print a document from Adobe Acrobat and Adobe Photoshop, with the emphasis on color management.

Using Adobe Acrobat Reader

The print process is very simple. Acrobat Reader is the most basic application for PDF files; several color
management tools common in more sophisticated applications are not explicitly present, and work by default
with presets that cannot be changed.

For example, there is no way to select a working color space; a default color space, most likely sRGB, is applied.
This color space is used for screen display, for example. Also, as an alternative color profile when no other is
specified by a file, as will be explained later.

1. Click File > Print.
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2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver settings can
be adjusted by clicking the Properties button.

Printer:

- Properties ‘ Advanced

Copies: [1

Pages to Print
®an
() Current page

[CIPrint in grayscale (black and white)

Comments & Forms

Docurnent and Markups

Summarize Comments

O Pages |= 186
* Maore Options

e

Page Sizing & Handling @

Scale: 97%
8.27x 1169 Inches

[E] Muttiple [E] Bookiet
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CIFit
) Actual size
(®) Shrink oversized pages @

(O Custom Scale: 100 % o

[[] Choose paper source by PDF page size

Orientation:

(®) Aute. portrait/landscape
() Portrait

O Landscape

Page 1 of 194

Page Setup... Print Cancel

Adjust the color settings in the driver properties window. Click the Properties button in the Print dialog and
set the Color option in the Color mode section. Click OK.

Click the Advanced button in the Print dialog box to set color management options. Check the box Let
printer determine colors.

Printer: v Propesties Advanced Heip &
Copies: |1 < . d white)
Pages to Print rms
@Al PostSeript Options u‘ .
. arkups ~
() Current page £
. & Comments
) Pages ’7 - I
Send at Start
* More Opticns
Download Asian Fonts x 11,69 Inches
Page Sizing & Handling
,D—I BE 1 ] Diseclored background correction
Size Poi
| Color Managernent
OFit 2
() Actual size E] Let printer determine calors
(®) Shrink oversized pages Treat grays as K-anly grays @
() Custom Scale: [ eserve Black
[]Choose paper source by PDE Preserve CMYK Primaries
Orientation: CJPrint As Image
(®) Ao portrait/landscape [ Simulate Ovesprinting
O Portrait [ Print to File
(O Landscape
oK Cancel
<" "
Page 1of 199
Page Setup... Print Cancel

If the document contains several color profiles and you are not sure what the result will be, you can flatten
the document first and print it as seen on the screen. To do this, check the box Print As Image in the
Advanced Print Setup dialog box. In this case, the rasterization is performed by Acrobat Reader before
calling the driver; whereas, if you do not check this box, the rasterization is performed by the driver. So
checking the box may have a visible effect on the look of the printed document.
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Using Adobe Acrobat Pro

This is a professional application that allows full color management. See briefly described, the options to select a
working color space, convert images to a desired color space, and print.

1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working color
space by default. To choose a working color space, first click Edit > Preferences.
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# P Accessories

= [F Troubleshooting paper issues

= [ Troubleshooting print-quality issues

=P Troubleshaoting ink cartridge and printhead issues
“ [ Troubleshooting general printer issues

# [ Front-panel emor messages
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2. Inthe Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.
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3. PDF files can contain elements with different color profiles. Some may have color profiles, some may not.
The working color space will affect only those without a color profile. If you want to attach a specific color
profile to the document, you must convert the contents of the document as follows. First, select Convert
Colors from View > Tools > Print Production or by clicking the icon in the status bar.

ENWW

Print a document with the correct colors



4.  Select the elements you want to convert by specifying matching criteria (object type and/or color type) and
then the conversion attributes. If you want to change the embedded color profile, you can select Any Object
and Any Colorspace in the Matching Criteria section. In the Conversion Attributes section you can choose, for
example, to embed an Adobe RGB (1998) profile by selecting it as the Conversion Profile, checking the
Embed box, clicking the OK button, and saving the file to keep the changes. The saved file will have an
embedded Adobe RGB color profile.

Comemrion Commandy Discument Colom

5. Toprint the document, choose a printer from the Print dialog box, click the Properties button, and in the
Color mode section, set the color options.

i IMPORTANT:  Select Print in color and Printer managed colors.

6. Inthe Print dialog box, click the Print button to print the document.

Using Adobe Photoshop
The printer can manage colors directly.
1. InPhotoshop, click File > Print, then select your printer.

2. Inthe Color Management section, set the Color Handling option to Printer Manages Colors.

Printer Setup
Printer:

Coples: |1 Print Settings...
Layout: [§] @

¥ Color Management
Remember to enable the printer’s color
management in the print settings dialog box.

Document Profile: sRGE IEC61966-2.1

| Color Handling: | Printer Manages Colors

Printer Profile:
| Normal Printing ¥

Rendering Intent: | Relative Colorimetric  *

¥ Description

3. Inthedriver's Color section, ensure that the color management option is Printer managed colors. This is the
correct option because you have already selected Printer Manages Colors in Photoshop.
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Print a project using Autodesk AutoCAD

Set up a plot to print from a model or a layout.

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

Parametric
) . J,a - ¢ Move () Rotate

- & - % Copy \ Mirror

18 - B Stretch @l Scale R Amay
Draw ~ Modify +

Line Polyline Circle  Arc

Drawing] Drawing2* +

3. The Plot window opens.
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4. You can see further options by clicking the circular button in the lower right corner of the window.

A
Page sehup

Name: <None x> v Add...

Printer/plotter

Nae:

Properties...

Plotter:
Where: File

Desaription:

Plot to fle

Paper size Number of copies

ANSI expand A (8.50 x 11.00 Inches) ~ 1 =

Flot area

What to plot:

Plot scale
Fit to paper
Extents v

Scale: |Custom

Plot offset (origin set to printable area) i inches

¥ | 1L.175375 inches
Y 0.000000 inch

Preview... Apply toLa

[] center the plat 315.9

Scale lineweights

=

[17? NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD

viewport objects that are sent for printing.

5. Select your printer and click the Properties button.

6.  Select the Device and Document Settings tab, and click the Custom Properties button.

10.

11.
12.

A
Page setup
Name: <None> h Add,..
Printer fplotter &
Name: & HP Design
Gereral Pots  Device and Document Settings
Plotter: HP Designlet T!
=]
Where: EMEA, long T
ere: [Barcelon L Media
Description: [0\ Source and Size <Size: Oversize: Latter [portrait]>
£ Medis Destination <Defaulty
[IFiot to file Graphics
8, Custom Propertiss
Paper size 9--[.5? User-defined Paper Sizss & Calibration

Oversize: Letter {portrait)

Plotarea
What to plot:
Extents ~

Plot offset (origin set to printa

X: | 1175375 inches
y: |0.000000 inch

Preview... Apply to

Custom Paper Sizes
Modify Standard Paper Sizes [Printabls dres)
Fiter Paper Sizes
Plotter Caibration

= PMP File Name <None>

Access Custom Dislog

Press the following button to access the
device diver-specific user-interface.

=

Custom Properties...

Import Saveds

0K Cancel

Defauls

Help

In the Driver, select the paper type that you intend to use.

Select the print quality.

If you intend to print on roll paper, you must decide where the printer should cut the paper.

e  With the Windows driver: Select Margin Layout options > Clip content by margins.

Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

Click the OK button and save your configuration changes to a PC3 file.

When you have clicked the OK button in the Plot window, the printer will construct a print preview.
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Print a presentation

Setup AutoCAD or Photoshop presentations.

Using Autodesk AutoCAD

Print a presentation with Autodesk AutoCAD.
1. Open the AutoCAD file and select a layout.

Home | Inset Annotate Parametic View Manage Output

S . 7 M- P Move () Rol
o+ 4

& - % Copy \ Mirror

Line Polyline Circle  Arc

Draw ~

Drawing] Drawing2*

3. Ensure that the correct printer is selected, then click the Properties button.
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4.  Select the Device and Document Settings tab, and click the Custom Properties button.
A
Name: <None> h Add..
Printer fplotter
bEmE S Design Gereral Pots  Device and Document Settings
Plotter: HP Designlet T
Where: EMEA /Barcelong gg Media
Desaription: | L) Source and Size <Sias: Oversize: Letter [pottait]>
[ ga;:;:ds\a Destination <D efault>
8, Custom Propertiss
Paper size == User-defined Paper Sizes & Calibration
| Custom Paper Sizes
Oversize: Letter (portrait) | § Modify Standard Paper Sizes [Printable Area)
Filter Paper Sizes
Plot area Platter Calibration
What to plot: =5 PMP File Name <None>
Extents b Access Custom Dislog
Press the following button to access the
Plot offset (origin set to printa dewice diiver-specific user-interface.
x [1a7se7s | meves =7
v inch Lustom Properties...
Preview... Apply g
Impart. Save As. Defaults
oK Cancel Help
5. Inthe Driver, select the paper type that you intend to use.
[17? NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected
roll.
6.  Select the print quality.
7. If youintend to print on roll paper, you must decide where the printer should cut the paper.
e  With the Windows driver: Select Margin Layout options > Clip content by margins.
8.  Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.
9.  Click the OK button and save your configuration changes to a PC3 file.
10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.
Using Adobe Photoshop
Print a presentation with Adobe Photoshop.
1. InPhotoshop, click File > Print and then select your printer.
2. Click Print settings, then select the Document size option.
3. Choose from the available paper sizes.
If you don't find your desired paper size, create it by following the instructions in Custom paper sizes
on page 35.
4.  Select Show preview before printing. You may also wish to change the default paper source, paper type and
print quality.
5. Inthe Color section, the default color management option is Printer managed colors, which is the correct

option as you have already selected Printer Manages Colors in Photoshop.
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Print and scale from Microsoft Office

With the scale options you can scale documents to print at a particular size.

Using Microsoft PowerPoint

Scale a job to fit your page size and clip content by margins.

1. Click File > Print, and select the name of your printer.

Print

Copies: | 1 z
=

Print

Save As Printer

Save as Adobe -
o ‘% Ready

Printer Properties

Print

Settings
Share /ﬁ Print All Slides
Print entire presentation
Export
Slides: ®
Close . Full Page Slides .
Print 1 slide per page
—  Collated
IS o
Account ‘EIEI 123 123 123 ‘
Feedback ‘ . Color .
Options Edit Header & Footer

2.  Click the Scale option to scale the document to a particular size.
3. Select the Paper Source and Paper Type.
4.  Depending on your driver version:

e  With the Windows driver: Select the Margin Layout options, then Clip content by margins.

Using Microsoft Project

Use the proper scale option to scale a document to a particular size.
1.  Click File > Print.

2. Select your printer's name.
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3. Inthe Settings section, you can choose the pages to print, the orientation, and the paper size.

©

Print

New -
= Copies: |1 =
Open =
Print
Save
Save As Printer
Save as Adabe = ey
PDF eady
Print .
Settings

Share Print Entire Project
= !

Print the project from start to finish
Export
Dates: |10/31/2017 | to [1/22/2018

Close -

Pages: |1 2| to E] <

[=8  Landscape Orientation
Account

Ad
Options D 827" x11.69"

4.  Click Page Setup to choose the Paper Size you want.

Page Setup

Printer Properties

s

Page | Margins | Header| Footer | Legend| view |

Orientation

O Portrait (® Landscape

Sealing

(® Adjustto: | 100 |-> % normal size

O Fitto: |1 2 pageswide by |1 = tall

Other

Paper Size: [ A4 -

First page number: | Auto

Print Preview.. | | Options... print.. Cancel

5. Select Options to go to the printer driver.

s

Page | Margins | Header| Footer | Legend| view |

Orientation
O Portrait (® Landscape
Scaling

(® Adjustto: | 100 |-> % normal size
O Fitto: |1 2 pageswide by |1 = tall

Other

Paper Size: | A4 ~

First page number: | Auto

print Preview... | || gptions... Print... oK

Cancel

The default options are probably suitable: Paper source: Automatic and Paper Type: Use Printer Settings.

document in Project.
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Click Proper scale option to scale the document to a particular size. Alternatively, you can scale the
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8 Handling ink cartridges and printhead

There are 4 replaceble ink cartridges that supply the printhead. You can check status information, and easily
change an ink cartridge when required.

About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper.

To purchase additional cartridges, see Accessories on page 64

A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices. Avoid
touching pins, leads and circuitry.

[ﬁ’g’/"f NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.

Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer.

The memory chip stores a limited set of anonymous information about the usage of the printer, which can
include the following: the date when the cartridge was first installed, the date when the cartridge was last used,
the number of pages printed using the cartridge, the page coverage, the frequency of printing, the printing
modes used, any printing errors that may have occurred, and the product model. This information helps HP to
design future products to meet our customers' printing needs.

The data collected by the memaory chip does not include information that could be used to identify a customer or
user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling
program (HP Planet Partners: http://www.hp.com/recycle). The sampled memory chips are read and studied in
order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party possessing
the cartridge may be able to access the anonymous information on the memory chip. If you prefer to not allow
access to this information, you can render the chip inoperable. However, after you render the memory chip
inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's ability to
collect printer usage information. To do so, access the front panel and tap , then Preferences» Automatically

send printer data, or access the Embedded Web Server, and click Settings» Preferences® Data Collection
settings. This does not prevent the cartridge from working normally in other respects. However, if you change
your mind later, you can restore the factory defaults to resume collecting printer usage information.

Check ink cartridge status

Information about the evolution of the ink cartridges.

To view the ink levels of your ink cartridges, swipe down the dashboard and tap on the front panel. For more
information, tap the specific cartridge.
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You can also get this information from the HP Utility (Windows only):

e Inthe EWS go to Home» Estimated Cartridges Levels or Tools» Supply Status; In the HP DesignJet Utility,
go to the Supplies tab to see each cartridge's status.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 85 ..

Replace an ink cartridge

There are two occasions when you need to replace an ink cartridge.

e  Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can
use up the remaining ink in the first cartridge at a more convenient time).

e  Theink cartridge is empty or faulty, and you must replace it to continue printing.

A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION:  Remove an ink cartridge only if you are ready to insert another one.

949

[ NOTE: When a cartridge runs out of ink, the current job is cancelled.

1. Make sure the printer is turned on.

2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

3. Open the window.

4.  Press the ink cartridge to unlock it.

52 Chapter 8 Handling ink cartridges and printhead ENWW



5. Remove the ink cartridge.

6. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same
colored letter as the cartridge you are installing.

7.  Close the window.

About the printhead

The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto the
paper.

A CAUTION:  Observe precautions when handling the printhead, because it is an ESD-sensitive device. Avoid
touching pins, leads, and circuitry.

For information on replacing printheads, see Replace the printhead on page 58.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a used,
refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode.
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HP is unable to warrant the performance of the printing system when operated outside of environmental
specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect
the printer and the printheads from damage due to unexpected conditions, and is in operation when the icon is
displayed on the printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use ariginal HP ink cartridges. HP DesignJet printing systems, including original HP inks
and printheads, are designed and engineered together to provide uncompromising print quality, consistency,
performance, durability, and value—with every print.

993

B NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous
ink system and install genuine HP (or compatible) cartridges.

[%’/r NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or
compatible) to continue printing.

[%)/r NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.
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9 Maintaining the printer

Checking printer status and maintenance are essential to keep your equipment in prime condition. Keep your
printer clean, diagnose issues, calibrate, replace the printhead when required, and keep your software up to date.

Check printer status

There are various ways you can check the current printer status.

e  Ifyou start the HP Utility (Windows only) and select your printer, you see a page of information describing
the status of the printer and its paper and ink supplies.

e Ifyou access the Embedded Web Server, you see information about the general status of the printer.

e  From the front panel, you can get information about the loaded paper and the ink levels.

Take care of the printer
The printer is not designed for any purpose other than printing.
It is not recommended to use the printer as a table, for two reasons:
e  The surface can easily be damaged.

e  Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

AWARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean
it. Do not let water get inside the printer.

/\ CAUTION: Do not use abrasive cleaners on the printer.

Print Quality Diagnostic Report

There are two test patterns designed to highlight printhead reliability problems.

To print the Print Quality Diagnostic Report

Check the performance of the printhead that is currently installed in your printer, and whether it suffers from
clogging or alignment problems.

1. Use the same paper type that you were using when you detected a problem. The test patterns are easiest
to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View
information about the paper on page 27.

3. Atthe printer's front panel, tap , then Image Reports > Print Quality Report.
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r.% NOTE: The report can also be requested from the Embedded Web Server.

It takes about two minutes to print the Print Quality Diagnostic Report.

Test Pattern 1

If the lines are not straight and connected, align the printheads.

Test Pattern 2

If you see thin white lines across any of the colored blocks, clean the printheads.

If you have an issue with the diagnostic page, there are steps you can take, depending on the problem.

Corrective actions

1. Ifthelinesin Test Pattern 1 are not straight and connected, align the printhead (see Align the printhead
on page 57).

2. Ifany of the colored blocks in Test Pattern 2 show white lines, are faded or completely missing, clean the
printhead (see Clean the printhead on page 56). Follow the front-panel prompts and perform all three
levels of cleaning if necessary.

3. If the problem remains, clean the printhead again.

4.  If the problem remains, replace the ink cartridge (see Replace an ink cartridge on page 52) corresponding to
the streaked, faded, or missing color block in Test Pattern 2.

5. If the problem remains, replace the printhead (see Replace the printhead on page 58). If the printhead is
still in warranty, contact HP Support (see Contact HP Support on page 98).

Clean the printhead

If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an
increasing amount of ink. After each stage, review the gquality of the printed page. You should initiate the next
phase of cleaning only if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

[%9 NOTE: Cleaning uses ink, so clean the printhead only when necessary.

r_'%’ NOTE: Failing to turn off the printer correctly can cause print-quality problems.
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Clean the printhead from the front panel

When your print quality seems poor, and you are next to the printer, this is a simple method to address the issue.

1. Make sure there is paper in the input tray or a roll loaded.

2. Goto the front panel and tap , then Printer Maintenance ® Clean the Printhead.

Clean the printhead from the Embedded Web Server
You can clean the printhead remotely using an ordinary Web browser running on any computer.
1. Make sure there is paper in the input tray or a roll loaded.

2. Inthe Tools tab on the Embedded Web Server, then tap Tools» Utilities » Print Quality Toolbox» Clean
Printhead, and follow the instructions on the screen.

Clean the printhead from the HP Utility (Windows only)

You can manage this and clean the printhead from a computer with a USB, TCP/IP, or Wi-Fi connection.
1. Make sure there is paper in the input tray or a roll loaded.

2. Inthe Support tab of the HP Utility, click Printhead Cleaning, and follow the instructions on the screen.

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in
graphical elements.

Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed

or replaced. You may need to align the printhead after a paper jam or if you are experiencing print-quality
problems.

@ IMPORTANT:  Load A4 and letter in portrait. Do not load them in landscape.

1. Load the paper you wish to use, see Paper handling on page 23. You can use a roll or a cut sheet; plain
white paper is recommended.

A CAUTION: Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the window is closed, as a strong light source near the printer during printhead realignment can

affect alignment.

3. From the front panel, tap , then Printer Maintenance® Align the Printhead.

’L%y NOTE: Printhead alignment can also be started from the Embedded Web Server (Tools» Utilities » Print

Quality Toolbox » Optimize and Improve ® Align Printhead), or from the HP Utility (Windows: Support >
Printhead Alignment; Mac OS X: Information and Print Quality > Align).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

5. The process takes about five minutes. Wait until the front-panel display shows the process complete before

using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead and

try again.
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Replace the printhead

When the printhead is out of ink or has an issue that cannot be fixed, you must replace it. After replacement, the
printer will automatically perform a printhead alignment on the loaded paper.

TP If you would like to perform the printhead alignment on a different paper (perhaps from the multi-sheet
tray), you could change the paper before starting this procedure. Plain white paper is recommended. A4 and
letter paper should not be loaded in landscape orientation.

1. Make sure the printer is turned on.

2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

3. From the front panel, tap , then Printer Maintenance > Replace printhead.

-

4.  From the front panel, tap Continue to proceed.

5. Open the main door.

6.  Press eachink cartridge to unlock it.

7. Remove all the inks cartridges, then tap Next.

\
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8.  Open the printhead latch.

Remove the printhead, keeping it vertical to avoid getting ink on the connections.

=5

Insert the new printhead.

L s
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11.  When finished, close the latch and tap Next.

12. Insert the ink cartridges. Make sure that you insert each ink cartridge into the slot that has the same
colored label as the cartridge you are installing.

@9 IMPORTANT:  If the printhead is new, install new ink cartridges. New ink cartridges are required for
successful printhead replacement.

13. Close the main door.

14. The front panel recommends a printhead alignment.

Clean the encoder strip

You can use a small damp cloth to remove unwanted residue.
1. Turn off the printer: Press the power key and unplug the power cable.

2. Using tap water and a small cloth that will not leave fibers in the printer, dampen the cloth and remove any
excess water, so that the cloth is damp but not wet.

3. Open the main door.
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4.  Hold the cloth in aninverted U shape around the encoder strip and carefully wipe until no further ink
residue appears on the cloth. Be very careful not to scratch the encoder strip with your fingernails or any
other object. Make sure that you are holding the cloth correctly.

2943

B NOTE: Do not move the carriage away from the service station.

5.  (Close the main door.

6.  Turn the printer on.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of
dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select
the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if
you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the
paper advances. See Troubleshooting print-quality issues on page 76 to determine whether paper advance
calibration will solve your issue.

Recalibrating the paper advance procedure

The recalibration procedure takes approximately three minutes.

9 TIP: Itis recommended to only have the paper loaded that you want to calibrate.

1. Fromthe front panel, tap , then Printer Maintenance > Paper advance calibration > Calibrate ready

paper. When prompted by the front panel, confirm the paper source and type. The printer automatically
recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

’L%y NOTE: Do not worry about the paper advance calibration image.

If you are satisfied with your print, continue using this calibration for your paper type. If you see
improvement in your print, continue with the next step. If you are dissatisfied with the recalibration, return
to the default calibration, see Return to default calibration on page 61.

3. If you would like to fine tune the calibration, or are using a transparent paper, swipe down the dashboard
and tap [, then scroll down the menu and tap Image quality maintenance » Paper advance
calibration® Adjust paper advance.

4.  Select the percentage of change from —99% to +99%. To correct light banding decrease the percentage. To
correct dark banding increase the percentage.

5. Tosave the value, tap OK on the front panel.

6.  Wait until the front panel displays the status screen and reprint your print.

Return to default calibration

ENWW

This sets all the corrections made by the paper advance calibration to zero. To return to the default paper
advance calibration value, you must reset the calibration.

1. Fromthe front panel, tap , then Printer Maintenance ® Paper advance calibration» Reset ready paper.

2. Wait until the front panel displays the operation has completed successfully.

Recalibrate the paper advance
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Move or store the printer

If you need to move the printer, take care to prepare it correctly to avoid possible damage.
1. Do not remove the ink cartridges or printhead.

2 Make sure that no paper is loaded.

3. Turn off the printer using the Power key at the back.

4.  Unplug the printer's power cord.
5

Disconnect any cables connecting the printer to a network or a computer.

A CAUTION: To avoid being pinched, keep your fingers away from the gap between the bottom of the printer and

the stand while you're moving the printer with stand.

CAUTION:  If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the
printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off for a
six weeks or more, preparing the printhead could take up to 45 minutes.

A CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In this case,

you need to replace the printhead with a new one.

Firmware update

There are various ways to download and install firmware updates; choose the one you find most convenient.

[%’/]’9 NOTE: A firmware update package can be large; you may want to consider whether there are any implications

for your network or Internet connection.

You can configure the printer to download firmware updates automatically whenever they become available: see
Automatic firmware update on page 14.

e  Using the front panel, tap , then Printer Maintenance» Update the Printer » Check Now to check

whether new firmware is available. If new firmware is available, you are given the opportunity to download
and install it.

e  Using the Embedded Web Server, click Tools» Printer Updates® Firmware Updates» Check Now.
e  Using the HP DesignJet Utility under Windows, select your printer, the Support tab, then Firmware Update.

The firmware includes a set of the most commonly used paper presets.

Software update

Manual updates of printer drivers and other software are available for your printer.

Go to: http://www.hp.com/go/DesignJetStudio/software.

Printer maintenance kits

Three maintenance kits are available for your printer, containing components that may need to be replaced after
long use.

When one of them is needed, a message is displayed on the front panel and by the HP Utility and you should
contact HP Support (see ) and request the maintenance kit. The kits are installed by service engineers only.
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HP Support Assistant

This helps you maintain your computer and printer. It helps you avoid or resolve issues.

The HP Support Assistant guides you to expert support when required and helps you maintain peak performance
and resolve problems through automatic updates, built-in diagnostics, self-help, and a variety of assistance
options. A wealth of information and support resources for your HP computers and printers is only a few clicks
away.

HP Support Assistant is pre-installed on HP computers sold after October 2012, running Windows 7, Windows 8,
or Windows 10 operating systems.

[% NOTE: Features may vary depending on the version installed, your computer model, and your location.

HP Support Assistant can also be installed used on non-HP computers.

If HP Support Assistant is not installed on your computer running Windows 7, Windows 8, or Windows 10, you
can download the latest version by selecting it on the printer driver installer package, or clicking:
http://www.hp.com/go/hpsupportassistant.
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10 Accessories

Supplies and accessories can be ordered for your printer.

How to order supplies and accessories

There are two ways to order supplies or accessories for your printer.

e \Visit http://www.hplfmedia.com on the Web.

e  (ontact HP Support (see HP Support Center on page 97).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

Ink cartridges can be ordered singularly of in packs of 3. There is also a printhead replacement kit you can order
for your printer.

Table 10-1 Ink cartridges

Cartridge Part number
HP 712 29ml Cyan DesignJet Ink Cartridge 3ED67A
HP 712 29ml Magenta DesignJet Ink Cartridge 3ED68A
HP 712 29ml Yellow DesignJet Ink Cartridge 3ED69A
HP 712 38ml Black DesignJet Ink Cartridge 3ED70A
HP 712 80ml Black DesignJet Ink Cartridge 3ED71A
HP 712 Cyan DesignJet Ink Cartridge 3-Pack 3ED77A
HP 712 Magenta DesignJet Ink Cartridge 3-Pack 3ED78A
HP 712 Yellow DesignJet Ink Cartridge 3-Pack 3ED79A
HP 712B 38ml Black DesignJet Ink Cartridge 3ED28A
HP 712B 80ml Black DesignJet Ink Cartridge 3ED29A

Table 10-2 Printhead

Printhead Part number
HP 713 DesignJet Printhead Replacement Kit 3EDS8A
Order paper

HP printers can use a wide range of paper.

To check the lastest information related to papers supported by your printer, go to: http://www.hplfmedia.com.
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Order accessories

There are accessories available for your printer.

Name Product number
HP DesignJet 24-in Spindle B3Q36A
HP DesignJet 36-in Spindle B3Q37A

Introduction to the accessories

You can increase your printer's possibilities with accessories.

Spindle

With extra spindles, you can quickly change from one paper type to another.
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11 Troubleshooting paper issues

Step by step instructions are provided to help you identify and resolve paper issues.

Paper cannot be loaded successfully

There are various reasons why you may have issues loading the paper.
e  Ensure that no paper is already loaded.
e  Ensurethat the paper is far enough inside the printer, you should feel the printer grab the paper.

e Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-
panel display. The printer automatically attempts to straighten the paper.

e  The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load
There are checks to make and steps to correct any problems.
e  C(heckthat therollis at least 280 mm (11 in) wide: narrower rolls are not supported.

e  (Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the initial 20
mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.

e  (Check that the roll ends are tight against the spindle ends.

e  (heck that the spindle is correctly inserted.

e  (heck that the output tray is closed. The roll will not load when it is open.

e  (heck that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
e  (Check that all roll end plugs have been removed.

e  (Check that the paper is wound tightly on the roll.

e Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, follow the instructions on the front panel.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from
the end of the spindle until the edge is removed from the printer.

[%9 NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

There are checks to make and steps to correct any problems.

e  (Check that the sheet is more than 329 mm (12.95 in) wide (A3+). If it is that width or less, load it from the
multi-sheet tray.

e  (uide the sheet, especially thick papers, when the printer initially feeds the sheet.

e  Ensure that the sheet is aligned with the reference line on the roll cover.
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e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel
display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
In case of any problem, follow the instructions given on the front-panel display.
If you would like to start the load process again, cancel the process on the front panel; the printer ejects the

sheet from the front of the printer.

Unsuccessful load from the multi-sheet tray

There are checks to make and steps to correct any problems.

e  (Checkthat you have not loaded too many sheets into the tray. The maximum number of sheets depends
on the paper thickness: around 50 sheets of plain, standard paper.

e  (heck that the sheets are correctly loaded into the tray.

e  (heckthat the sheets are correctly adjusted and centered in the tray.

e  (heck that you have extended the input and output trays correctly: the first extension for A4, the second
for A3 paper.

If the paper is hanging over the back of the input tray as shown, it may fail to load.
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[%9 NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, because they
will deform.

Paper loading error messages
There is a list of front-panel messages related to paper loading, with the suggested corrective action.

Table 11-1 Error Messages

Front-panel message Suggested action

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much skew. Tap
OK to unload the roll automatically, then restart the process.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Paper too far from lateral edge Reload the cut sheet, aligning the right edge against the black stop on the spindle.

Paper load failed. Paper width is smaller than  Cut sheets smaller than ISO A3 must be loaded using the multi-sheet tray.
the minimum size supported by the selected
paper source.

Sheet too big During the load process the printer has detected that the sheet of paper is either too wide
or too long to be loaded correctly. Tap . to stop the load process. See Functional
specifications on page 100.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow or too
short to be loaded in the printer. Tap . to stop the load process. See Functional
specifications on page 100.

Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, photo or bond, coated or technical.

99

B NOTE: For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of ink for
glossy paper.

Transparent or translucent film

You may use clear of matte film.

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear film.
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If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte film.

Photo paper
There are different types of photo paper finishes that you can apply.

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper type
Photo Gloss Paper. For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type Photo Semi-gloss/Satin
Paper.

To increase gamut on photo paper, select paper type HP Universal Gloss Photo Paper or HP Universal Satin Photo
Paper, depending on the finish.

Bond and coated or technical paper

Your paper type selection for generic paper depends on the paper’s ink absorption capacity.

e  For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing Paper >
65 g/m2, depending on the weight of the paper.

e  For thin papers (< 90 g/m?) or uncoated papers (for example plain paper or bright white paper), select
paper type Bond and Coated Paper > Plain Paper. You can also select Recycled Bond Paper.

e  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.

e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink.

To use an optimized ink combination, select paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used.
To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:
e  Plain Paper
e  (oated Paper
e  Heavyweight Coated Paper

For other print-quality problems, see Troubleshooting print-quality issues on page 76.

Printer printed on the wrong paper type

This happens when the printer prints your job before you were able to load your desired paper.
You may have Use printer settings selected for the Paper Type in the printer driver.

When Use printer settings is selected the printer will print immediately on whichever paper is loaded. Load your
desired paper, see Paper handling on page 23, and select your paper type specifically in the driver.

e Inthe Windows driver dialog: Select your paper type from the Paper Type list.

e Inthe Mac 0S X Print dialog: Select the Paper/Quality panel, then from the Paper Type list, select your paper
type.
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%’9 NOTE: Use printer settings is the driver default.

Paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits for you
to decide what to do. There are several ways in which the loaded paper may be considered unsuitable.

e  The paper type is not as specified for the job.

e  The paper source (roll, multi-sheet tray, or manual feed) is not as specified for the job.

e  The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

e  Load the correct paper and resume printing.

e  Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.

e C(ancelthejob.

Roll has jammed

When a paper jam occurs, you normally see a message about it in the front-panel display.

1. Opentheroll cover.

2. Open the main door.
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3. Rewind the roll to create a loop. Cut the paper, if needed.

4.  Carefully remove any of the jammed paper that you can from the top of the printer.

5. Carefully remove any of the jammed paper from the front window.

6. Reload theroll, or load a new sheet; see Paper handling on page 23.

fi? NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure
and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see Multi-sheet tray has
jammed on page 72).

Prevent a jam

Depending on substrate type, roll condition, environmental conditions, image content, print mode etc. a jam may
be prevented by opening the main door halfway.
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Multi-sheet tray has jammed

Paper can jam in the multi-sheet tray for a variety of reasons and there are steps to follow to correct an issue.
Proceed as follows:
1. Remove as much paper as you can from the multi-sheet tray.

2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.
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3. Unlock the tray, using the rotary switch behind it.

4.  Pull out the tray.
—

N
Wy

5. Remove all paper from the tray.

,‘—-—.—__‘
6. Putthe trayin again.

/
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7.  Lock the tray.

A strip stays on the output tray and generates jams

If a small piece of paper has been cut, such as before printing a new roll, or after the front panel option Form
feed and cut has been used, the cut strip may remain in the output tray. Only when the printer is not printing,
reach into the tray and remove the strip.

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the bin

There are steps you can follow if there is an issue with the bin.
e  Ensure the binis correctly installed.
e  Ensurethe binis open.

° Ensure the bin is not full.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing.

See Change the drying time on page 28. If the paper is only partially ejected after the drying time, gently pull the
sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel,
see Form feed and form feed and cut on page 29.
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Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed. You can disable the cutter.

See Change the drying time on page 28. You can disable the cutter, see Turn the automatic cutter on and off
on page 28.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles,
and check that there are no pieces of paper in the cutter groove.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.
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12 Troubleshooting print-quality issues

Step by step instructions are provided for you to identify and resolve your issue.

General printing advice

To achieve the best performance from your printer, use only genuine manufacturer's supplies and accessories.

e  Genuine manufacturer's supplies and accessories have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 64.

e  Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 27). Also make sure that the paper type selected in
your software is the same as the paper type loaded into the printer.

A CAUTION:  If you have the wrong paper type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printhead.

e  (heck that you are using the most appropriate print-quality settings for your purposes (see Printing
on page 30). You are likely to see lower print quality if you have set the quality level to Fast.

e  (Check that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 103.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary).

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 27.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 30). In
some cases, you can overcome a print-guality problem merely by selecting a higher print-quality level. For
instance, if you have set the Print Quality level to Fast, try setting it to Best.

3. Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 55.

4. If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper advance
on page 61.

If the problem persists despite all the above actions, contact your customer service representative for further
support.
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Lines are too thick, too thin or missing

Check the paper type and settings, and run a report.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 27.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 30). Try
turning on the Maximum detail option (if available under the Color and Quality settings).

3. Iflines are too thin or missing, print the Print Quality Diagnostic Report. See To print the Print Quality
Diagnostic Report on page 55 .

4.  If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 61.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Lines appear stepped or jagged

Check your original image, and print-quality settings.

1. The problem may be inherent in the image. Try to improve the image with the application you are using to
editit.

2. (Check that you are using appropriate print-quality settings. See Printing on page 30.

3. Turn on the Maximum detail option (if available under the Color and Quality settings).

Lines print double or in the wrong colors

This problem can have various visible symptoms.

e  C(olored lines are printed double, in different colors.
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e  The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if recommended
in the report. See To print the Print Quality Diagnostic Report on page 55.

Lines are discontinuous

Check your print-quality settings and print a Print Quality Diagnostic Report.

1. Check that you are using appropriate print-quality settings. See Printing on page 30.

2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print
the Print Quality Diagnostic Report on page 55.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.
See Environmental specifications on page 103.

2. (Checkthat the paper type selected in the front panel is the same as the paper type you are using. See View
information about the paper on page 27.
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Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.
Select a lower print quality (such as Fast); the printer will then use less ink.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

If you are using glossy paper, try changing to a different type of glossy paper.

Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print
the Print Quality Diagnostic Report on page 55.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes,
you can try to improve line length accuracy.

Try the following:

1.

vk WwN

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 100.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner
or thicker than HP Matte Film will reduce line length accuracy.

Set Print Quality to Best.
Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 61.

Whole image is blurry or grainy

There are a series of steps and checks you can make to deal with this issue. Check the paper, settings, run
reports to find the issue etc.

1.

2.
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Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 27.

Check that you are printing on the correct side of the paper.
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5.

Check that you are using appropriate print-guality settings (see Printing on page 30). In some cases, you
can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you
have set the Print Quality to Fast, try using Best.

Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print
the Print Quality Diagnostic Report on page 55.

If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 61.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 27.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
Select a lower print quality (such as Fast); the printer will then use less ink.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

Handle prints carefully.
Avoid stacking prints on top of each other.

Catch your prints as they are cut from the roll and do not let them fall into the bin. Alternatively, leave a
sheet of paper in the bin so that freshly printed sheets do not make direct contact with the bin.

Increase the drying time. At the front panel, tap , then Setup > Print Settings > Drying Time > Extended.
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Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printhead
moves over the paper, the printhead may come into contact with the paper and smear the printed image.

This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Tap [l and also cancel the job from your
computer application. Soaked paper can damage the printhead.

If you notice poor print quality after this has happened, clean the printhead. See Clean the printhead on page 56.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 27.

2. Usearecommended paper type (see Order paper on page 64) and the correct print settings.

3. Ifusing sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

4.  Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper.

6.  Trytoincrease the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte
black ink if it knows that the paper will not retain it.

To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo Paper
category).

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-
quality slider to Best.
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See Printing on page 30 for more information.

Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality to Best, try setting the
guality to Fast.

| s

[

See Printing on page 30 for more information.

Vertical lines of different colors

If your print has vertical bands of different colors along it try changing the paper and/or adjusting the print-
quality settings.

1. Tryusing thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper. See Order paper on page 64.

2. Tryusing higher print-quality settings (see Printing on page 30). For instance, if you have set the Print
Quality to Fast, try setting it to Best.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material.
To avoid this problem:
1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, there are steps you can take.

Try the following:
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1. Check that the paper type you have loaded corresponds to the paper type selected.
2. (Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings. For the most accurate colors, select Normal or
Best quality.

4.  Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 55.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints

(depending on the type of lamination) with all paper types. For more information, consult your laminate provider.

Image is incomplete (clipped at the bottom)

If the image is incomplete you may have cut the data being received, or there could be a communication issue.

e Didyou tap Cancel before all the data were received by the printer? If so, you have ended the data
transmission and will have to print the page again.

e  There may be a communications problem between your computer and the printer. Check your USB or
network cable, or your Wi-Fi connection.

e  (Check to make sure that your software settings are correct for your current page size (for example, long-
axis prints).

e Ifyouare using network software, make sure it has not timed out.

Image is clipped
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Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software.

e  (Check the actual printable area for the paper size you have loaded.
printable area = paper size —margins

e  (Check what your software understands to be the printable area (which it may call "printing area" or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

e Ifyou have defined a custom page size with very narrow margins, the printer may impose its own minimal
margins, clipping your image slightly. You may want to consider using a larger paper size.

e If yourimage contains its own margins, you may be able to print it successfully by using the Clip Contents
by Margins option (see Select margins options on page 36).

e Ifyouaretrying to print a very long image on a roll, check that your software is capable of printing an
image of that size.

e  You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

e Ifnecessary, reduce the size of the image or document in your software application, so it fits between the
margins.

Colors are fading
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Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output.

Here are some suggestions to help you to avoid this problem:
e  Select a smaller page size and scale to the desired final page size in the driver or in the front panel.
e  Save thefile in another format, such as TIFF or EPS, and open it with another application.

e  Reduce the resolution of bitmap images in your application software.

[%r NOTE: If you're using Adobe applications, ensure that you have installed the latest version.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or
the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the
problem.

If you still have a problem

If you still experience print-quality problems after applying the advice then there are other steps you can try.
Here are some further things that you can do:

e  Tryusing a higher print-quality option. See Printing on page 30.

e  (Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded
from http://www.hp.com/go/DesignJetStudio/software.

° Check that your printer's firmware is up to date. See Firmware update on page 62.

e  (Check that you have the right settings in your software application.
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13 Troubleshooting ink cartridge and printhead
issues

Step by step instructions are provided for you to identify and resolve your issue.

Cannot insert an ink cartridge

It is important that you are using the correct type of cartridge, and that it is well placed in its slot.

1.
2.
3.

Check that you have the correct type of cartridge (model number).

Check that the colored label on the cartridge is the same color as the label on the slot.

Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side

up and readable.

A CAUTION:  Never clean inside the ink cartridge slots.

Ink cartridge status messages

There are ink cartridge status messages to alert you to an issue.

OK: The cartridge is working normally, with no known problems.

Missing or Damaged: There is no cartridge present, or it is not correctly connected to the printer (shown
with an X on the status screen).

Low: The ink level is low.

Out of ink: The cartridge is empty.

Not genuine HP: The cartridge is not a genuine HP cartridge.
Wrong slot: The cartridge has been inserted into the wrong slot.

Incompatible: The cartridge is incompatible with this printer.

Cannot insert the printhead

It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1.

2
3.
4
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Check that you have the correct type of printhead (model number).
Check that you have removed the orange protective cap from the printhead.
Check that the printhead is correctly oriented.

Check that you have correctly latched the printhead, see Replace the printhead on page 58.

Cannot insert an ink cartridge
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14 Troubleshooting data communication issues

Step by step instructions are provided for you to identify and resolve your issue.

Communication failures between computer and printer

Some symptoms are apparent when there is an issue.

Fixed IP

The front-panel display does not show the Printing message when you have sent an image to the printer.
Your computer displays an error message when you are trying to print.

Your computer or printer hangs (stays idle), while communication is taking place.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

Ensure that you have selected the correct printer in your application, see Printing on page 30.

Ensure that the printer works correctly when printing from other applications.
Remember that very large prints may take some time to receive, process and print.

If the printer is connected to a network, check the printer connectivity status: the printer should have an IP
address and it should match the IP address specified in the printing computer. If the addresses do not
match, then configure it correctly; if the issue persists, check your network configuration or try connecting
to the printer by USB cable.

Try another interface cable.

If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a
different USB port on the computer.

If the printer is connected to a wireless network, you can request a diagnostic report from the front panel:
tap , then Settings > Print Wireless Network Test. Alternatively, try moving the printer closer to the
wireless router, or try connecting the printer by wired network or USB cable.

Increase the lease time of your DHCP server device.
Set a fixed IP address for your printer that will not be changed by DHCP.

Configure the printer and driver to refer to the hostname instead of the numeric IP address.

Set a fixed IP address for the printer from the front panel.

1.

2.

Hostname

Go to the front panel and tap or .

At the bottom of the screen, tap Settings > Advanced setup > IP settings > OK > Manual, and enter the IP
address, the subnet mask, and the gateway (those settings should be provided by your network
administrator).

You can use the hostname instead of the numeric IP address.
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1. Goto the front panel and tap B8] or =X .

2. Take anote of the IP address and the hostname (HPXXXXXX format).

3. If your computer is running Windows, go to Control Panel > Printers, right-click the printer and click
Properties > Ports > Configure Port, and in the Printer name or IP address field enter the hostname.

Wired network issues

If you are unable to install the HP software provided with the printer, then youneed check some things.
Check that:

e  All cable connections to the computer and the printer are secure.

e  The network is operational and the network hub is turned on.

e Allapplications, including virus protection programs, spyware protection programs, and firewalls, are closed
or disabled for computers running Windows.

e The printerisinstalled on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter the IP
address manually in the installation program. For more information, see Network configuration page

on page 90.
Though it is not recommended that you assign a static IP address to the printer, you might resolve some

installation problems (such as a conflict with a personal firewall) by doing so. See Communication failures
between computer and printer on page 86

Network port created does not match printer IP address (Windows)

If you are using a computer running Windows, make sure that the network ports created in the printer driver
match the printer's IP address.

1. Print the printer’s network configuration page.
2.  Click Start, point to Settings, then click Printers or Printers and Faxes.
—or—
Click Start, click Control Panel, then double-click Printers.
3. Right-click the printer icon, click Properties, and then click the Ports tab.
4.  Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the
network configuration page. If the IP addresses are different, change the IP address in the dialog box to
match the address on the network configuration page.

6.  Click OK twice to save the settings and close the dialog boxes.

Wireless network issues

Step by step instructions are provided for you to identify and resolve your issue.

Wireless network troubleshooting

Check that the wireless is on, that there are no issues with cable connections or the network.
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Make sure the wireless (802.11) light at the top left of the front panel is turned on .
If the blue light is not lit, the wireless capabilities may not have been turned on. To turn on wireless, tap ,
then Settings > Wireless > On.

Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable
turns off the printer's wireless capabilities.

Restart components of the wireless network.

Turn off the router and the printer, and then turn them back on in this order: router first and then the
printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, turning
off the power and then turning it back on can solve a network communication issue.

Run the Wireless Network Test.

For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, tap
, then Settings > Print Wireless Network Test. If a problem is detected, the printed test report includes
recommendations that could help to solve the problem.

Advanced wireless network troubleshooting
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If you have tried to fix the problem, and are still unable to connect to your printer to the wireless network, then
there are steps you can take.

Try the following:

1.

Make sure that your computer's wireless networking has been turned on. For more information, see the
documentation that came with your computer.

If you are not using a unigue network name (SSID), then it is possible that your computer could be
connected to a nearby network that is not yours. The following steps can help you to determine whether
your computer is connected to your network.

Windows:

a.  Click Start, click Control Panel, point to Network Connections, then click View Network Status and
Tasks.

Click Start, then Settings, click Control Panel, double-click Network Connections, click the View menu,
then select Details.

Leave the network dialog box open while you continue to the next step.

b.  Disconnect the power cord from the wireless router. The connection status of your computer should
change to Not Connected.

€. Reconnect the power cord to the wireless router. The connection status should change to Connected.

Mac OS X:

A Click &311 in the menu bar at the top of the screen. From the menu that appears, you can determine if
the Wi-Fiis turned on and which wireless network your computer is connected to.

= TIP:  For more detailed information about your Wi-Fi connection, click System Preferences in the
Dock. If the wireless connection is working correctly, a green dot appears next to the list of
connections. For more information, click the Help button in the window.
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If you are unable to get your computer connected to your network, contact the person/company that set up
your network or the router manufacturer as there may be a hardware issue with your router or computer.

Print the printer's Wireless Configuration page (see Network configuration page on page 90). After the
page has been printed, check the Network Status and URL. The Network Status is Ready if the printer is
actively connected to a network, or Offline if it is not (in the latter case, run the Wireless Network Test). The
URL is the network address assigned to the printer by your router; you need it to connect to the printer's
Embedded Web Server.

If you have established that the computer and the printer both have active connections to a network, you
can check whether they are on the same network by trying to access the printer's Embedded Web Server
(see Access the Embedded Web Server on page 17).

If you cannot access the Embedded Web Server and are sure that both the computer and printer have
active connections to the same network, the firewall security software could be blocking communication.
Temporarily turn off any firewall security software running on your computer, and try to access the
Embedded Web Server again. If you can access it, try using the printer for printing.

If you are able to access the Embedded Web Server and use your printer with the firewall turned off, you
need to reconfigure your firewall settings to allow the computer and printer to communicate with each
other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with the
firewall turned off, try enabling the firewall software to recognize the printer.

If you have the HP software installed, you can check the printer’s status from your computer to check
whether the printer is paused or offline, preventing you from using it.

Windows:

a.  Click Start, point to Settings, then click Printers or Printers and Faxes.
—or—
Click Start, click Control Panel, then double-click Printers.

b.  If the printers on your computer are not being displayed in Details view, click the View menu, then
click Details.

¢. Do one of the following, depending on the printer status:
e If the printer is Offline, right-click the printer, and click Use Printer Online.
e [f the printer is Paused, right-click the printer, and click Resume Printing.

d.  Tryusing the printer over the network.

Mac OS X:

a.  Click System Preferences in the dock, then click Printers & Scanners.

b.  Select the printer, then click Print Queue.

¢. If Jobs Stopped appears in the resulting window, click Start Jobs.

If you install the HP software a second time, the installer may create a second version of the printer driver
in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or connecting to
the printer, make sure the correct version of the Windows printer driver is set as the default.

a.  Click Start, point to Settings, then click Printers or Printers and Faxes.
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Click Start, click Control Panel, then double-click Printers.
b.  Right-click the printer icon, and then click Properties, Document Defaults, or Printing Preferences.

c.  Onthe Ports tab, look for a port in the list with a checkmark. The version of the printer driver that is
connected wirelessly has Standard TCP/IP Port as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and click
Set as Default Printer.

8.  Tryrestarting the HP Network Device Support service (Windows only).
a. Delete any print jobs currently in the print queue.
b.  Onthe desktop, right-click My Computer or Computer, then click Manage.
¢.  Double-click Services and Applications, then click Services.
d.  Scroll down the list of services, right-click HP Network Devices Support, then click Restart.
e.  After the service restarts, try using the printer over the network again.
If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your firewall may
be interfering, or there may be a problem with your network configuration or router. Contact the person who set
up your network or the router manufacturer for help.

Add hardware addresses to a wireless access point (WAP)

90

MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called “hardware
addresses”) of devices that are allowed to gain access to the network through the WAP.

If the WAP does not have the hardware address of a device attempting to access the network, the WAP denies
the device access to the network. If the WAP filters MAC addresses, then the printer's MAC address must be
added to the WAP’s list of accepted MAC addresses.

1. Print the network configuration page. For more information, see Network configuration page on page 90.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted MAC
addresses.

Mobile Printing issues

For issues, visit the links listed here.

See: http://www.hp.com/go/designjetmobility (availability varies by product, country, and region).

Also see http://www.hpsmart.com.

Network configuration page

If the printer is connected to a network, you can print a network configuration page to view the network settings
for the printer.

You can use the network configuration page to help troubleshoot network connectivity problems. If you need to
call HPR, it is often useful to print this page before calling. To print the network configuration page from the front
panel: tap , then Internal Prints > User Information Prints > Network Configuration Page.

Chapter 14 Troubleshooting data communication issues ENWW


http://www.hp.com/go/designjetmobility
http://www.hpsmart.com

ENWW

General Information: Shows information about the current status and active connection type of the
network, and other information, such as the URL of the Embedded Web Server.

802.3 Wired: Shows information about the active wired network connection, such as the IP address, subnet
mask, default gateway, and hardware address of the printer.

802.11 Wireless: Shows information about your wireless network connection, such as the hostname, IP
address, subnet mask, default gateway, and server.

Miscellaneous: Shows information about more advanced network settings.

e  Port9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP
port on the printer is the default port for printing. It is accessed by HP software (for example, the
HP Standard Port).

e  LPD: Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer
spooling services that may be installed on various TCP/IP systems.

[1-7;?9 NOTE: The LPD functionality can be used with any host implementation of LPD that complies with
the RFC 1179 document. The process for configuring printer spoolers, however, might differ. See your
system documentation for information about configuring these systems.

e  Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used on
small networks for IP address and name resolution (through UDP port 5353), where a conventional
DNS server is not used.

e  SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides a
framework to allow networking applications to discover the existence, location, and configuration of
networked services in enterprise networks. This protocol simplifies discovery and use of network
resources such as printers, Web servers, fax machines, video cameras, file systems, backup devices
(tape drives), databases, directories, mail servers, and calendars.

e  Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery (WS
Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the
printer. Disable unused print services to prevent access through those services.

[%F NOTE: For more information about WS Discovery and WSD Print, visit http://www.microsoft.com/.

e  SNMP: SNMP (Simple Network Management Protocol) is used by network management applications
for device management. The printer supports SNMPv1 protocol on IP networks.

e  WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the printer
automatically obtains its IP address from that server and registers its name with any RFC 10071 and
1002-compliant dynamic name services as long as a WINS server IP address has been specified.

Connected PC(s): Lists the computers connected to this printer, as well as the last time these computers
accessed the printer.
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15 Troubleshooting general printer issues

Step by step instructions are provided for you to identify and resolve your issue.

Printer does not start

If the printer does not start (the front panel is blank), hold down the Power key for a few seconds and check
whether the Power LED turns orange while the key is held down.

e Ifyousee no orange light, no power is reaching the printer; check that the power cord is correctly plugged
in. If the problem persists, call HP Support (see HP Customer Care on page 97) and explain that you have a
problem with the power supply.

e Ifyou see the orange light, wait for the printer to check if it makes a beeping sound:

e  Three beeps means an electronic problem; call HP Support and explain.

Printer does not print

If allis in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file
you have sent from your computer may not start printing when expected:

e  You may have an electrical power problem. If there is no activity at all from the printer, and the front panel
does not respond, check that the power cord is connected correctly and that there is power available at the
socket.

e  You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this
case, turn off the printer using the Power key at the back and unplug the power cord, wait until the
electromagnetic environment has returned to normal, then turn it on again. If you still experience
problems, contact your customer service representative.

e  You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

e Ifyouare printing on a sheet, you must specify Printer Automatic or Sheet or Tray as the paper source in
your printer driver.

Printer seems slow

Here are some possible explanations:

e  Didyou set the print-quality to Best or Maximum detail? Best-quality and maximum detail prints take
longer.

e  Didyou specify the correct paper type when loading the paper? Some paper types require more time for
printing; for example, photo and coated papers require more drying time between passes. To find out the
printer's current paper type setting, see View information about the paper on page 27.

e Ifyour printer is connected by network, check that all components used in the network (network interface
cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from
other devices on the network?
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e  Didyou specify Extended drying time in the front panel? Try changing the drying time to Optimal.

e Ifyour printer is connected by Wi-Fi, switch to a wired network.

Front panel is frozen

If the front panel displays a fixed image and you are unable to use it, call HP Support:.

See HP Customer Care on page 97.

Cannot access the Embedded Web Server

If you have not done so already:

Please read: Access the Embedded Web Server on page 17.

[i?)”f} NOTE: If you connect directly to your printer with a USB cable, you cannot access the Embedded Web Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

e Ininternet Explorer for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check
the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced
button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

e InSafari for Mac 0S X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button.
Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not
used, in the bypass proxy settings for the Hosts & Domains field.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Restore factory defaults and settings

If you disabled any functions or changed some settings and want to change them back, you can restore the
printer to the original factory settings or network settings.

Defaults

Restore the printer to the original factory defaults.

1. Fromthe front panel, at the top of the screen, tap or swipe down the tab to open the dashboard, then tap
Bl

2. Tap Printer Maintenance.

3.  Tap Restore.

4.  Tap Restore Factory Defaults.
A message appears stating that the factory defaults will be restored.

5.  Tap Continue.

Settings
Restore the printer to the original factory settings.

Cold Reset removes all user configured settings, including saved administrator passwords, network
configurations, stored jobs, selected country/region and language, address book entries, and web services
account information.

ENWW Front panelis frozen 93



You can use this feature if you are selling the printer, or giving it to someone else, and want to be sure that all
personal information has been removed.

1.

Alerts

94

From the front panel, at the top of the screen, tap or swipe down the tab to open the dashboard, then tap
B

Tap Printer Maintenance.

Tap Restore.

Tap Cold Reset.

A message appears stating which settings will be restored.

Tap Continue.

Your printer can communicate two types of alerts:

Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer
driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is
able to print.

Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a
possible unprintable situation, such as a preventive maintenance or low ink.

Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a warning,
it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear
when the printer becomes idle and there is not another more severe alert.

Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.

Print queue: The print queue shows alerts. The driver warns about job configuration settings that may
produce a problem in the final output. If the printer is not ready to print, it displays a warning.

HP Utility: If the HP Utility is installed, alerts can be automatically displayed under Windows: a new panel
opens on your screen with a list of alerts for each printer. This display of alerts can be activated on
Windows by the Alerts Settings in the HP DesignJet Utility. You can also see the list of active alerts in the
Overview tab of the HP DesignJet Utility.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as
displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from
completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions
to achieve your required result.

[:7? NOTE: There are environments that do not support bidirectional communication. In those cases, alerts do

not reach the job owner.
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16 Front-panel error messages

Printer issues appear in the front panel automatically along with the recommendation of how to fix them.

Text messages and numerical error codes

Error messages indicate that there is a printer error that needs attention. When they appear, follow the advice in

ENWW

the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the
recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support

on page 98.

Table 16-1 Text messages

Message

Recommendation

Cartridge low

The indicated cartridges are low. You do not have to replace the
cartridge(s) now. HP recommends you have a replacement available
for when the cartridge is depleted and will need to be replaced.

Cartridge very low

The indicated cartridges are very low and will be depleted soon.
While you do not have to replace the cartridges now, HP
recommends you have a replacement available for when cartridges
are depleted and will need to be replaced.

Cartridges depleted

The indicated cartridges are depleted. Replace these cartridges.

Maintenance kit 1 required

Contact HP Support. See Contact HP Support on page 98.

Maintenance kit 2 required

Contact HP Support. See Contact HP Support on page 98.

Maintenance kit 3 required

Contact HP Support. See Contact HP Support on page 98.

Cartridge Problem

Insert cartridges of the correct color as needed. See Replace an ink
cartridge on page 52.

Carriage jam

See Roll has jammed on page 70 or Multi-sheet tray has jammed
on page 72.

The width of the paper is smaller than the minimum size supported
by the selected media source. Loading cancelled.

Remove the paper and load paper of the correct size.

Loaded paper is too wide. Manual unload required.

Remove the paper manually and load paper of the correct size.

The paper is too far from the lateral load line. Try loading the paper
again.

Remove and reload the paper.

Please manually unload roll paper and try again.

Rewind the roll manually.

The currently loaded paper has too much skew and cannot be
corrected automatically. Tap Remove, and then load the paper
again.

Remove and reload the paper.

The rollis out of paper, and the current job has been cancelled. Load
another roll, and then send the job again.

Load a new roll.

You are printing a multipage job. Load another sheet to continue
printing or cancel the job.

Load another single sheet.

Text messages and numerical error codes
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Table 16-1 Text messages (continued)

Message Recommendation

Multi-sheet tray is out of paper. Load paper in multi-sheet trayand ~ Load paper into the multi-sheet tray.
press OK to continue printing or cancel the job.

End of roll has been reached. It is not possible to load the roll. Load a new roll.

Missing or failed printhead. Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead. See
Replace the printhead on page 58.

NOTE:  The error message does not permit returning to the home
screen to start the printhead replacement. Instead, press Show

more.
Refilled or depleted cartridge detected Check the cartridge.
Used cartridges might not have enough ink to complete start-up. A new printhead has been inserted without a new set of ink
Open ink door to replace the cartridges. cartridges. Replace the cartridges not marked as new. See Replace

an ink cartridge on page 52.

Wrong file format. The file format is incorrect or not supported. The printer cannot
process the job, which will be discarded.

Table 16-2 Numerical error codes

Error code Recommendation
0001-0082 The battery of the real-time clock has expired; contact HP Support. See Contact HP Support
on page 98.
0021-0017 Service station error. There may be a paper or carriage jam. Check and clear the paper path if necessary

and restart the printer.

0041-0017,0042-0117 There may be a paper or carriage jam. Check and clear the paper path if necessary.

0085-XXXX Feeding paper problem. Restart the printer.
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17 HP Customer Care

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing
comprehensive, proven support expertise and new technologies to give you unigue end-to-end support.

Introduction

Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services,

phone and Web support, software updates and self-maintenance services.

To find out more about HP Customer Care, see Contact HP Support on page 98.

To register your warranty, visit http://register.hp.com/.

HP Professional Services

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP DesignJet printers and solutions.

HP Support Center

Join the HP community at the HP Support Center, your large-format printing community, for 24x7 access to
support.

Multimedia tutorials

Step-by-step how-to guides

Downloads: the latest printer firmware, drivers, software, paper presets, etc.

Technical support: online troubleshooting, customer care contacts and more

Workflows and detailed advice for completing various printing tasks from particular software applications
Forums for direct contact with the experts, both HP and your colleagues

Warranty tracking online, for your peace of mind

Latest product information: printers, supplies, accessories, software, etc.

Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at HP Support Center on page 97.

By customizing your registration for the products you have purchased and your type of business, and by setting
your communication preferences, you decide the information you need.

Download printer software

Be sure to follow the software installation instructions.

Install the printer software from: http://www.hp.com/go/DesignlJetStudio/software.
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HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time
options:

e  Next business day
e  Same business day, within four hours (may not be available in all countries)
There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, visit http://www.hp.com/go/printservices.

HP Installation

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, visit http://www.hp.com/go/printservices.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It
enables HP to ship replacement parts directly to you (the end user) so that you can replace them.

Using this program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

e  Available for most HP products currently under warranty or contract.
e  Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/qgo/selfrepair.

Contact HP Support

HP Support is available to you by telephone.

What to do before you call:

e  Review the troubleshooting suggestions in this guide.

e  Review the relevant driver documentation.

e Ifyou have installed third-party software drivers and RIPs, see their documentation.

e Ifyou call one of the HP offices, please have the following information available to help us answer your
questions more quickly:
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e  The product you are using (the product number and the serial number, found on the label at the back
of the product)

e [fthereis an error code on the front panel, note it down; see Text messages and numerical error
codes on page 95

e  The computer you are using

e  Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers)

e  Thetype of interface used on your product (USB, network, or Wi-Fi)
e  The software and driver name and version number that you are currently using
e  The Printer Service information:

e  From the Embedded Web Server:

In a Web browser, enter your printer's IP address to access the Embedded Web Server. To access
the printer's service information:

Tap Product Information® Printer Information
Tap Product Information® Supply Status
Tap Tools» Reports» Usage Report
Tap Tools» Reports» Error Log
° From a computer:

You can print the service information from the front panel:

Tap [ then Reports® Printer Status Report
Tap [ then Reports® Print Quality Report

Tap [i&], then Reports» Error Log

Telephone number

Your HP Support telephone number is available on the Web.

Visit http://welcome.hp.com/country/us/en/wwcontact_us.html.
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18 Printer specifications

Reference lists of physical, technical, ecological, etc. specifications for your printer.

Functional specifications

Your printer is designed to deliver CAD / construction drawings as well as high quality graphics.

Table 18-1 HP ink supplies

Printhead

One printhead

Ink cartridges

Cartridges containing 29 ml of ink: yellow, magenta, and cyan

Cartridges containing 38 ml of ink: black

Cartridges containing 80 ml of ink: black

Table 18-2 Paper sizes

Minimum Maximum
Roll width 279 mm (11in) 610 mm (24 in) or 914 mm (36 in)
Roll length 46 m (150 feet)
Roll diameter 100 mm (3.9in)
610 mm (24 in) roll weight 4.1kg (91b)
914 mm (36 in) roll weight 6.2kg (14 1b)

Sheet width

210 mm (8.27 in)

610 mm (24 in) or 914 mm (36 in)

Sheet length

279 mm (11 in)

1676 mm (66 in)

Paper thickness

0.3 mm (0.01in)

Paper weight

60 g/m2

280 g/m2 (220 g/m2 in multi-sheet tray)

Table 18-3 Printing resolutions

Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)
Best (glossy paper*) On 1200 % 1200 2400 % 1200

Off 600 x 600 1200 x 1200
Best (other papers) Off 600 x 600 1200 x 1200
Normal Off 600 x 600 1200 x 1200
Fast Off 600 x 600 1200 x 1200
Econofast Off 600 x 600 1200 x 1200
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* For a list of supported glossy papers, see Order paper on page 64.

Table 18-4 Margins

Top left and right margins 5mm (0.2 in)

Bottom margin 17 mm (0.67 in) (manual sheet)

Table 18-5 Mechanical accuracy

+0.1% of the specified vector length or +0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AQ printing material
in Best or Normal mode with HP Heavyweight Coated Paper roll feed.

Table 18-6 Graphic languages supported

HP DesignJet Languages
HP DesignJet Studio HP PCL3GUI, HP-GL/2 and HP RTL (Windows)
Printer series

Mobile Printing specifications
Easy wireless printing from your iPad, iPhone, Android, or other device.

Table 18-7 Mobile printing

Mobile printing Yes, directly from both iOS with AirPrint and Android with HP Print Service Plugin
Mobile devices supported by HP Mobile Smartphones and tablets

printing

Supported operating systems i0S, Android

0S versions i0S from 7.0 and Android from 4.4

Connectivity requirements Printer and mobile device must use the same network, or have internet connection if in

different networks

Supported file formats PDF, JPEG

Table 18-8 HP Smart App

Software HP Smart App

Mobile devices supported Smartphones, tablets, PC

Operating systems supported i0S from 11, Android from 5.0, Windows from 8.1, macOS from 10.11

Connectivity requirements Printer and mobile device must use the same network, or have internet connection if in

different networks

File formats supported PDF, JPEG, webpages, email attachments, Microsoft Office documents
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Table 18-9 Email printing

Mobile devices supported Smartphones, tablets, PC
Supported operating systems Any, as long as it has email
Connectivity requirements Cloud connection

Cloud features Remote printing through email
Supported file formats PDF

Max file size 10MB

Physical specifications

Printer models have both common and distinct specifications.

Table 18-10 Printer physical specifications

HP DesignJet Studio 24-in Printer HP DesignJet Studio 36-in Printer
Weight 34.7 kg (76.5 Ib) including stand 42.5 kg (93.7 Ib) including stand
Width 1013 mm (39.91n) 1317 mm (51.81n)
Depth 512 mm (20.1 in) without stand 572 mm (20.7 in) without stand
555 mm (21.8 in) with stand 555 mm (21.8 in) with stand
Height 329 mm (12.9 in) without stand 329 mm (12.9 in) without stand
932 mm (36.7 in) with stand 932 mm (36.7 in) with stand
1110 mm (43.7 in) with stand and multi-sheet tray 1110 mm (43.7 in) with stand and multi-sheet tray
extended extended

Memory specifications

Your printer has 1 GB of memory.

Table 18-11 Memory specifications

Printer Memory

HP DesignJet Studio series 1GB

Power specifications

Use the electrical cord supplied with the printer and the power supply voltage specified on the label. Avoid
overloading the printer's electrical outlet with multiple devices.

Table 18-12 Printer power specifications

Type: Values:
Source 100-240V ac +10%, auto-ranging
Frequency 50/60 Hz
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Table 18-12 Printer power specifications (continued)

Type: Values:
Maximum current 1200 mA
Average consumption 35W

Ecological specifications

This product complies with the WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC.

To determine the ENERGY STAR qualification status of these product models see http://www.hp.com/go/
energystar.

Environmental specifications

Recommended operating and storage temperature and humidity.

Table 18-13 Printer environmental specifications

Type: Values:

Operating temperature 5t0 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type
Storage temperature —25t055°C (<13 t0 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0to95% RH

Maximum altitude when printing 3000 m (9850 ft)

Acoustic specifications

Declared noise emission levels for the HP DesignJet Studio Printer series. Sound Pressure Levels at bystander
positions and Sound Power Levels have been measured.

Table 18-14 Printer acoustic specifications

Idle sound power <3.4B(A)
Operating sound power 5.8B(A)
Idle sound pressure <16 dB(A)
Operating sound pressure 42 dB (A)
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Glossary

AirPrint
Apple technology that helps you create full-quality printed output without the need to download or install drivers.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a
particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of
the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the
printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to
minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the
printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink cartridges). Additionally, to
reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body
movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Fast Ethernet
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of
negotiating slower speeds when required for compatibility with older Ethernet devices.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with
original USB. Most personal computers today use Hi-Speed USB.
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HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2

HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O

Input/Output: this term describes the passing of data between one device and another.

ICC

The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.
Ink cartridge

A removable printer component that stores ink of a particular color and provides it to the printhead.
IP address

May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether
IPSec is being used or not.

IPv4 address
A unigue identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unigue identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the
world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unigue identifier used to identify a particular device on a network. It is a lower-level identifier
than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate with
every other device in the same network. This allows data to be moved between computers and devices, and allows devices
such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it
on the paper, through a cluster of nozzles.
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Spindle
Arod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

UsB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB
(sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to your
printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

WiFi
This term is used for any wireless local area network products that are based on the Institute of Electrical and Electronics
Engineers' (IEEE) 802.11 standards.
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